Notices

© Keysight Technologies, Inc. 2008-2020

No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies, Inc. as governed by United States and international copyright laws.

Revision
Version 06.12.0000

Edition
March 1, 2020

Available in electronic format only

Published by:
Keysight Technologies, Inc.
1900 Garden of the Gods Road
Colorado Springs, CO 80907 USA

Warranty

The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Keysight disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Keysight shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Keysight and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology License

The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

U.S. Government Rights

The Software is “commercial computer software,” as defined by Federal Acquisition Regulation (“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
In This Book

This book is your guide to programming Keysight DigitalTestApps.

• Chapters 1-4 describe how to use an existing remote client:
  • Chapter 1, “Keysight DigitalTestApps Remote Interface,” starting on page 9.
  • Chapter 2, “Using Sample Remote Clients,” starting on page 17.
  • Chapter 3, “Remote Programming Languages and Sample Code,” starting on page 41.
  • Chapter 4, “Recommended Remote Programming Practices,” starting on page 77.
• Chapter 5, “Developing a Remote Client,” starting on page 83, describes how to create new remote clients.
• Chapter 6, “Troubleshooting,” starting on page 133, lists common problems and resolutions.

How to use this book

Start by reading the Keysight DigitalTestApps Programming Getting Started guide; then, read all the chapters in this guide in order.
Contents

In This Book  /  3

1  Keysight DigitalTestApps Remote Interface

   Remote Interface Documentation  /  10
   Keysight KS8400A Test Automation for PathWave (TAP) Interface  /  13
   .NET Interface  /  14
   LabVIEW Interface  /  16

2  Using Sample Remote Clients

   ARSL Command Line Utility  /  18
   Simple GUI Remote Client  /  20
   Simple Message Handling Remote Client  /  22
   Message Handling Remote Client  /  24
   LabVIEW Simple Remote Client  /  27
   LabVIEW Demo Remote Client  /  31
       Connecting to the Automated Test Application  /  33
       Selecting/Running Tests  /  34
       Set/Get Configuration  /  35
       Obtaining Results  /  36
       Deleting Results  /  37
       Saving/Loading Projects  /  37
       ARSL  /  38
       Compliance Limit Set  /  38
   Application Sequencer  /  39

3  Remote Programming Languages and Sample Code

   The Keysight KS8400A Test Automation for PathWave (TAP)  /  42
4 Recommended Remote Programming Practices

Determine required tasks by first using the graphical user interface / 78

Verify the remote commands one at a time / 79

Check the log / 80

5 Developing a Remote Client

Plugin for Keysight KS8400A Test Automation for PathWave / 84

Simple Remote Client / 86

File description / 88

Source code description / 88

ARSL Command Line Utility Implementation / 90

Simple GUI Remote Client Implementation / 93

Simple Message Handling Remote Client Implementation / 97

Message Handling Remote Client Implementation / 100

LabVIEW Simple Remote Client / 108
6 Troubleshooting

How to Manage the App Migration to Keysight / 134
Error Messages and Resolution / 135
How to Check Which Port an Application is Using / 138
How to Configure a Remote Interface User Port / 140
If your PC Has Two Network Interface Cards / 142
How To Test Two-way .NET Remoting Between Your PC and Your Scope / 143

Index
1 Keysight DigitalTestApps Remote Interface

This chapter describes the fundamentals of the Keysight DigitalTestApps Remote Interface. If you haven't done this already, please read the Getting Started guide for important information needed to use this Programming Guide more effectively.

Whether you're using an existing remote client or developing your own, you need the following information to understand how to send instructions to the automated test application.

There are two basic types of commands: properties and methods.

- Properties represent data values in the automated test application. They can be read (query value) and in some cases written to (set value).
- Methods are functions which the automated test application can execute. They may require input parameters and/or provide return values.

In addition, some property actions and method calls use custom types defined by the automated test application. Custom types are classes containing the required data.
Remote Interface Documentation

Besides the Guide you are currently reading, there are other important documents which describe aspects of the Keysight DigitalTestApps Remote Interface:

**In the Toolkit**

The following document is located in the base folder of the Automated Test Application Remote Development Toolkit:

- Keysight_DigitalTestApps_Programming_Getting_Started.pdf

The following documents are located in the two "Documents" subfolders of the Automated Test Application Remote Development Toolkit:

- Keysight DigitalTestApps Remote Interface for TAP.chm.
- Keysight DigitalTestApps Remote Interface for .NET.chm.
- Keysight DigitalTestApps Remote Interface for LabVIEW.chm.

**NOTE**

Please see the readme.txt files located in the "Agilent-Keysight Transition" and "Keysight Apps Only" subfolders for guidance on which location to use.

The .chm files describe each of the elements of the remote interface, including properties, methods, types, etc.

**On the Server**

The following application-specific document is located in the "help" folder of the automated test application's installation directory. For automated test apps that run directly on an oscilloscope, this folder may be found in either of these locations:

```
c:\Program Files\Agilent_or_Keysight\(platform)\Apps\(application name)\help\(application name)_Remote_Prog_Ref.chm (or .pdf)
```

where "(platform)" is FlexDCA, Infiniium, InfiniiVision, or M8070A

- Or -

(Infiniium real-time on WinXP only) `c:\scope\apps\(application name)\help\(application name)_Remote_Prog_Ref.chm (or .pdf)`

For automated test applications that run on a separate PC, this folder may be found in:

```
c:\Program Files\Agilent_or_Keysight\(platform)\Apps\(application name)\help\(application name)_Remote_Prog_Ref.chm (or .pdf)
```

where "(platform)" is FlexDCA, Infiniium, InfiniiVision, or M8070A

- Or -

(Infiniium real-time only)

```
c:\Program Files\Keysight\Scope\Apps\(application name)\help\(application name)_Remote_Prog_Ref.chm (or .pdf)
```

**NOTE**

For Windows 7, substitute "Program Files (x86)" for "Program Files".
This help file (.chm or .pdf) describes application-specific configuration variable names and values, test names and IDs, and external instrument names. These are used as parameters or returned as results by various elements of the Keysight DigitalTestApps Remote Interface. The TAP.chm, .Net.chm, and LabVIEW.chm help files (described above) refer you to this application-specific document in their descriptions of remote interface elements that require application-specific values. You may view the remote interface help file(s) through the application's Help > Remote Interface menu (applications supporting remote interface version 2.00 or later, only).

**NOTE**

The TAP remote interface is a wrapper around the .NET remote interface. The help topics in TAP.chm contain links to their associated .NET.chm topics, which often provide additional information about the feature. When using TAP.chm, keep in mind that the elements designed for TAP use are located in namespace Keysight.DigitalTestApps.TAP.Plugin.TestSteps, while those found in the Keysight.DigitalTestApps.Framework namespaces are for .NET cross-reference use.

**NOTE**

The LabVIEW remote interface is a wrapper around the .NET remote interface. The help topics in the LabVIEW.chm contain links to their associated .NET.chm topics, which often provide additional information about the feature. When using the LabVIEW.chm, keep in mind that the elements designed for LabVIEW use are located in namespace Keysight.DigitalTestApps.RemoteTestClient, while those found in the Keysight.DigitalTestApps.Framework namespaces are for .NET cross-reference use.

**In the User Interface**

You may also obtain remote interface help directly from the application's user interface (applications supporting remote interface version 1.20 or later, only). Simply enable the "show remote interface hints" user preference (menu: View->Preferences :: Remote tab). If there is a remote command that can be used to accomplish an element's function, it can be found this way:

<table>
<thead>
<tr>
<th>User Interface Element</th>
<th>Hint Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Click a toolbar button.</td>
</tr>
<tr>
<td><strong>Set Up tab</strong></td>
<td>Right click a control and select <strong>Remote Interface Hint</strong>.</td>
</tr>
<tr>
<td>Run Tests tab</td>
<td></td>
</tr>
<tr>
<td>Results tab</td>
<td></td>
</tr>
<tr>
<td>Various run-time dialogs</td>
<td></td>
</tr>
<tr>
<td><strong>Select Tests tab</strong></td>
<td>Select a test (by clicking on its name) and check the description pane at the bottom of the tab.</td>
</tr>
<tr>
<td>Configure tab</td>
<td>Select a configuration item and check the description pane on the right side of the tab.</td>
</tr>
</tbody>
</table>
To find out what version of the remote interface an application supports, check its Help > About screen (if it does not appear there, the version is older than 1.20).
Keysight KS8400A Test Automation for PathWave (TAP) Interface

The elements of the TAP API are contained in a plugin named DigitalTest Apps API. This plugin contains steps that wrap access to the properties and methods of the .NET interface.
The elements of the .NET interface are contained in a library named Keysight.DigitalTestApps.Framework.Remote.dll and are divided into three namespaces:


This namespace contains the core remote interface features. A good starting place to look at is the RemoteAteUtilities class, which contains the methods used to connect to the automated test application, and the IRemoteAte interface, where most of the commands you will use are found.

The features in this namespace involve the remote client initiating some action and the automated test application responding, making use of the "remote client -> automated test app path" of the remote interface.

For example, to execute a remote interface method:

1. The client computer initiates the action (the method call).
2. The .NET Remoting layer transports the request to the server (the application running on oscilloscope or PC).
3. The application executes the method and generates the return value.
4. The .NET Remoting layer transports the return value to the client.


This namespace contains advanced programming features. The most important member is the AteEventSink, where most of the advanced commands you will use are found.

Some of the features in this namespace involve the automated test application initiating some action and the remote client responding, making use of the "automated test app -> remote client callback path" of the remote interface.

For example, one of the advanced features involves the ability to force dialogs that would normally display on the oscilloscope to display on the client instead. In this case:

1. The server (the application running on oscilloscope or PC) initiates the action (generates a message).
2. The .NET Remoting layer transports the message to the client computer.
3. The client displays the message and generates a response ("OK", "Cancel", etc.)
4 The .NET Remoting layer transports the response to the server.


This namespace contains remote interface-specific exception types that may be thrown during a remote operation.
LabVIEW Interface

The elements of the LabVIEW interface are contained in a library named Keysight.DigitalTestApps.RemoteTestClient.dll. This library contains methods that wrap access to the properties and methods of the .NET interface.
2 Using Sample Remote Clients

ARSL Command Line Utility / 18
Simple GUI Remote Client / 20
Message Handling Remote Client / 24
Simple Message Handling Remote Client / 22
LabVIEW Simple Remote Client / 27
LabVIEW Demo Remote Client / 31
Application Sequencer / 39

This chapter describes a set of ready-to-run sample remote clients that you can use to explore the Keysight DigitalTestApps Remote Interface.
ARSL Command Line Utility

The easiest way to try out the remote interface is by using a simple command-line remote client. This client lets you use plain text to execute the commands found in the .NET remote interface, which is described in Chapter 1, “Keysight DigitalTestApps Remote Interface,” starting on page 9.

To use this utility:

1. Using Windows Explorer, browse to the toolkit installation directory.
2. In the desired "Tools\C#" subdirectory, locate the "ARSL Command Line Utility" folder. Copy its contents to a new folder on your computer.
4. The folder on your computer should now look like this:

```
[Image showing folder structure]
```

5. Now open a Windows command prompt and browse to the folder you created:

```
[Image showing command prompt]
```

6. Ensure your configuration meets the requirements listed in "On the Server" in the Keysight DigitalTestApps Programming Getting Started guide, including launching the automated test application on the server.
7. Get the IP address of the target machine running the automated test application (oscilloscope or PC). On Windows-based machines, this may be obtained by typing "ipconfig" in a Command Prompt window.
8. Enter this in your Command Prompt window and press <enter>:

```
arsl -a 123.45.67.89 -c ApplicationName?
```

(substitute your actual IP address for 123.45.67.89)
Observe the automated test application's response. In the example above, an application named Reference Application responded with "RefApp Test".

You may also use this utility to execute scripts. An example, "SampleScript.txt" is included with the executable. Execute the script by entering this:

arsl -a 123.45.67.89 -s SampleScript.txt

(substitute your actual IP address for 123.45.67.89)

The command "ApplicationName?" and the contents of the file "SampleScript.txt" are examples of Keysight Automated Test Engine Remote Scripting Language (ARSL) commands. ARSL is described in more detail in "The Automated Test Remote Scripting Language (ARSL)" on page 44.

Note: To see all available options, enter this:

arsl -h
Simple GUI Remote Client

To see how a graphical user interface-based approach can work, try this client.

To use the simple GUI remote client:

1. Using Windows Explorer, browse to the toolkit installation directory.
2. In the desired "Tools\C#" subdirectory, locate the folder named "Simple GUI Remote Client". Copy its contents to a new folder on your computer.

**NOTE**

Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.


The folder on your computer should now look like this:

4. Ensure your configuration meets the minimum requirements listed in "On the Server" in the Keysight DigitalTestApps Programming Getting Started guide.

5. Get the IP address of the target machine running the automated test application (oscilloscope or PC). On Windows-based machines, this may be obtained by typing "ipconfig" in a Command Prompt window.

6. Now execute the file SimpleGuiRemoteClient.exe. When the main dialog displays, follow the steps to run a test.
Simple Message Handling Remote Client

Now take a look at a client that demonstrates basic message handling capabilities of the remote interface.

To use the simple message handling remote client:

1. Using Windows Explorer, browse to the toolkit installation directory.
2. In the desired "Tools\C#" subdirectory, locate the folder named "Simple Message Handling Remote Client". Copy its contents to a new folder on your computer.

   **NOTE**
   Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.


   The folder on your computer should now look like this:

![Folder structure](image)

4. Ensure your configuration meets the minimum requirements listed in "On the Server" in the Keysight DigitalTestApps Programming Getting Started guide.
5. Now execute the file SimpleMessageHandlingRemoteClient.exe:

![GUI](image)

6. When the main dialog displays, enter the IP address of the target machine running the automated test application (oscilloscope or PC). On Windows-based machines, this may be obtained by typing "ipconfig" in a Command Prompt window.
7 Click "Connect".

8 Enter a test ID. See Chapter 1, "Remote Interface Documentation" on page 10, for more information on getting your application's test IDs.

9 Click "Run".

The rest of the dialog presents options for using the remote interface to manage messages that the remote application displays:

- **Redirect app messages to remote client**
  
  When checked, the automated test application will not display messages on the oscilloscope. Instead, messages will be displayed on the client PC using a default display algorithm provided by the Keysight.DigitalTestApps.Framework.Remote DLL.

- **Handle simple callbacks programmatically**
  
  When checked, the default algorithm used in the "Redirect" option above will be replaced by a custom algorithm defined in the Simple Message Handling Remote Client program for "simple" messages (those not requiring value entry).

**NOTE**

If you close and relaunch the automated test application, it will initialize with default settings, such as Redirect=false. In this case, you should close and relaunch the simple message handling client to reinitialize it as well.
Message Handling Remote Client

Now take a look at a client that demonstrates advanced message handling capabilities of the remote interface.

To use the message handling remote client:
1. Using Windows Explorer, browse to the toolkit installation directory.
2. In the desired "Tools\C#" subdirectory, locate the folder named "Message Handling Remote Client". Copy its contents to a new folder on your computer.

**NOTE**

Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.


The folder on your computer should now look like this:

4. Ensure your configuration meets the minimum requirements listed in "On the Server" in the Keysight DigitalTestApps Programming Getting Started guide.

5. Get the IP address of the target machine running the automated test application (oscilloscope or PC). On Windows-based machines, this may be obtained by typing "ipconfig" in a Command Prompt window.

6. Now execute the file MessageHandlingRemoteClient.exe, passing in the IP address of the remote application as the first parameter:

7. When the main dialog displays, enter a test ID. See Chapter 1, "Remote Interface Documentation" on page 10, for more information on getting your application's test IDs.
8 Click "Run".

The rest of the dialog presents options for using the remote interface to manage messages that the remote application displays:

The following options use core remote interface features:

- **Suppress simple messages**

  When checked, the remote application will not display application-specific "simple messages". These are defined as messages that use only the standard Microsoft button responses, for example, OK/Cancel, Yes/No, etc., and do not require the user to enter any values. When the application needs to display a simple message, it will instead automatically respond to it with a predetermined default button selection.

- **Suppress data input messages**

  When checked, the remote application will not display application-specific "data input" messages. These are defined as messages that require the user to enter a single alphanumeric value. When the application needs to display a data input message, it will instead attempt to automatically respond to it with a predetermined value. In cases where the automated test application has no automatic response, the test will abort.

- **Action to take for "Connect" prompt**:

  This combo box presents three options that affect what happens when the remote application needs to display the standard "Change Physical Connection/Setup" dialog:

  - **Abort** — When this option is selected, the remote application will throw an exception.
  - **AutoRespond** — When this option is selected, the remote application suppresses the dialog and assumes you have made the connection.
  - **Display** — When this option is selected, the remote application will display the dialog.
• **Action to take for "CheckSignal" prompt:**

  This combo box presents three options that affect what happens when the remote application needs to display the standard "Check Signal" dialog:

  - **Abort** — When this option is selected, the remote application will throw an exception.
  - **AutoRespond** — When this option is selected, the remote application suppresses the dialog and assumes the signal is acceptable.
  - **Display** — When this option is selected, the remote application will display the dialog.

The following options use advanced remote interface features:

• **Redirect messages to client**

  When checked, the remote application will not display any of the above message types on the oscilloscope. Instead, the message will be displayed on the client PC using a default display algorithm provided by the Keysight.DigitalTestApps.Framework.Remote DLL.

• **Override default message handler**

  When checked, the default algorithm used in the "Redirect" option above will be replaced by a custom algorithm defined in the Message Handling Remote Client program.

The Core Feature options override the Advanced options. Thus, the application will not redirect simple messages to the client if they are being suppressed.

**NOTE**

If you close and relaunch the automated test application, it will initialize with default settings, such as suppress=false. In this case, you should close and relaunch the message handling client to reinitialize it as well.
LabVIEW Simple Remote Client

Now take a look at a simple remote client that demonstrates the use of the LabVIEW programming environment to control an automated test application. See "On the Client" in the Keysight DigitalTestApps Programming Getting Started guide for a list of minimum requirements.

1. Using Windows Explorer, browse to the toolkit installation directory that corresponds to the remote interface version supported by the automated test application you wish to control.

2. In the "Agilent-Keysight Transition\Source" subdirectory, locate the "LabView\Simple Client" folder. Copy its contents to "C:\LabView" on your computer.

3. In the "Agilent-Keysight Transition\Tools" subdirectory, locate the "LabView Remote Adapter" folder. Copy its contents to "C:\LabView".

4. Copy the application file Agilent.Infiniium.AppFW.Remote.dll (see "On the Client" in the Keysight DigitalTestApps Programming Getting Started guide) to "C:\LabView".

5. The folder on your computer should now look like this:

![Folder structure screenshot]

6. Ensure your configuration meets the minimum requirements listed in "On the Server" in the Keysight DigitalTestApps Programming Getting Started guide.
7 Get the IP address of the target machine running the automated test application (oscilloscope or PC). On Windows-based machines, this may be obtained by typing "ipconfig" in a Command Prompt window.

8 Open the file "SimpleRemoteClientProject.lvproj".

9 In the LabView Project Explorer, open the file "SimpleRemoteClient.vi".

10 Before launching the example program, the path for the working directory needs to be changed. Change the path to point to the directory where both the Agilent.Infiniium.AppFW.Remote.dll and Agilent.Infiniium.RemoteTestClient.dll are located.

11 Change the IP to point to the scope where the automated test application is running.
12 Launch the program. You should see the following screen:

13 Click Connect.
14 Enter the ARSL Command string.
15 Click Execute ARSL.

Observe the indicator for the status/return value of the ARSL Command executed.
LabVIEW Demo Remote Client

Now take a look at a more advanced client that demonstrates the use of the LabVIEW programming environment to control an automated test application. See "On the Client" in the Keysight DigitalTestApps Programming Getting Started guide for a list of minimum requirements.

1. Using Windows Explorer, browse to the toolkit installation directory that corresponds to the remote interface version supported by the automated test application you wish to control.

2. In the "Agilent–Keysight Transition\Source" subdirectory, locate the "LabView\Demo Client" folder. Copy its contents to "c:\LabView" on your computer.

3. In the "Agilent–Keysight Transition\Tools" subdirectory, locate the "LabView Remote Adapter" folder. Copy its contents to "c:\LabView".

4. Copy the application file Agilent.Infiniium.AppFW.Remote.dll (see "On the Client" in the Keysight DigitalTestApps Programming Getting Started guide) to "c:\LabView".

5. The folder on your computer should now look like this:

![Image of LabVIEW folder structure]

6. Ensure your configuration meets the minimum requirements listed in "On the Server" in the Keysight DigitalTestApps Programming Getting Started guide.
Using Sample Remote Clients

7 Get the IP address of your oscilloscope. This may be obtained by displaying the "GPIB Setup" dialog via the "Utilities" menu on the oscilloscope.

8 Open the file "Example Labview Remote Client.lvproj".

9 In the LabView Project Explorer, open the file "Main Interface.vi".

10 Before launching the example program, the path for the working directory needs to be changed. Change the path to point to the directory where both the Agilent.Infiniium.AppFW.Remote.dll and Agilent.Infiniium.RemoteTestClient.dll are located.

11 Launch the program. You should see the following screen:
Connecting to the Automated Test Application

Enter the IP address of the oscilloscope where the Automated Test Application is running; then, click Connect.
Selecting/Running Tests

Select the tests to run from the list box; then, click Run to start the tests. If you select multiple tests, they will run one after another. The list of available tests depends on the current configuration setting.

The number of trials to run for the selected tests can be changed via the spinner control.

Click Refresh Test List to update the choice of tests available.

**Test Plans**
When a remote application supports the Test Plan feature, check Enable Test Plans to run the tests with it. Check Skip Completed Permutations to skip all completed permutations of the Test Plan feature.

**Results**
Select the preferred Store Mode for keeping track of the test results such as worst trials, best trials, last N trials, and events. Existing test results may be Replaced or have new results Appended to them. Refer to "Keysight DigitalTestApps Remote Interface for .NET.chm" for more details on the different store modes available.

**Events**
In order for the application to react to a particular event of interest, check On Event and select the action to be taken when that event occurs. Select the Event of interest, there can be up to 2 events at a time. The choice of the 1st event would affect what is available as the 2nd choice. Note that certain events are only applicable to specific automated test applications.

**E-mail**
Check Send Email to enable email sending when tests have completed execution or aborted.
Set/Get Configuration

To set an automated test application configuration value, enter the "Configuration Name" and "Configuration Value" in the appropriate text boxes and click **Set Configuration**.

To get a configuration value from the automated test application, enter the Configuration Name in to the appropriate text box and click **Get Configuration**. The value for that variable will be displayed in the "Configuration Value" text box.

Refer to the individual automated test applications and framework guide for the available configurations.

Select the preferred action to be taken whenever the application requests for a change in the physical set up. Refer to "Keysight DigitalTestApps Remote Interface for .NET.chm" for more details on the individual actions.

Select the preferred action to be taken whenever the application checks the signal before execution of a test. Refer to "Keysight DigitalTestApps Remote Interface for .NET.chm" for more details on the individual actions.
Obtaining Results

Select the tests from the list box, and click **Get Test Results** to view the results. The results will be displayed in the following table:

The following attributes are displayed for each selected test:

1. Status – Pass / Fail.
2. Test Name.
3. Test ID.
4. Trial Number.
5. Parameter that was measured.
6. Value of the measurement.
7. Passing margin.

If a test with no result is selected, the "Parameter Name" column displays "No Results".
Deleting Results

To delete all the results for all tests, click **Delete Results**.

Saving/Loading Projects

To save a project, enter the full path of the location on the oscilloscope, for example, C:\TestData\USB\GenericHubDevice; then, click **Save Project**. The project is called "GenericHubDevice" and saved at "C:\TestData\USB\GenericHubDevice". Note that this saves the project on the oscilloscope. Checking **Overwrite Existing Project** causes a project already saved with the same name to be overwritten.

To load the project saved in the example above, the path would be "C:\TestData\USB\GenericHubDevice\GenericHubDevice". Click **Load Project** to load a previously saved project. Checking **Discard Unsaved Changes** loads the selected project, ignoring all previously unsaved changes for the current project.

To create a new project, click **New Project**. Checking **Discard Unsaved Changes** creates a new project ignoring all the previously unsaved changes for the current project.
ARSL

Enter the ARSL command and click **Execute ARSL**. The results are displayed in the ARSL Status box.

Compliance Limit Set

Select the **Limit Set Type** of choice and provide the **Limit Set Name** and **Limit Set Path** (the path setting is only applicable for UserDefined limits). Check **Discard Conflicting Results** to remove all conflicting results when a limits set is activated.
Application Sequencer

The Application Sequencer lets you construct test plans consisting of one or more saved projects created by one or more Infiniium automated test applications. For example, if you are performing USB Type-C testing, the Application Sequencer will let you execute USB, Display Port, and Thunderbolt tests and view results all from one console.

See this folder for more information:

C:\ProgramData\Keysight\DigitalTestApps\Remote Toolkit\Version x\Tools\DigitalTest Application Sequencer\
Using Sample Remote Clients
3 Remote Programming Languages and Sample Code

The Keysight KS8400A Test Automation for PathWave (TAP) / 42
The Automated Test Remote Scripting Language (ARSL) / 44
Microsoft .NET / 52
Python / 61

This chapter describes some of the languages you may use to program an automated test application, and provides code snippets to demonstrate language use.
The Keysight KS8400A Test Automation for PathWave (TAP)

The Keysight KS8400A Test Automation for PathWave (TAP) version 9 provides powerful, flexible and extensible test sequence and test plan creation with additional capabilities that optimize your test software development and overall performance. The N5452A Remote Toolkit includes a "DigitalTest Apps API" plugin for TAP that enables you to include control of automated test apps in your TAP test plans using a set of predefined steps enabling connections, configuration, test execution and results export.

To add this plugin to your TAP installation, use TAP to import the associated TapPackage:

1. In the TAP user interface, open Menu: Tools > PackageManager > Settings and add this N5452A toolkit path to the Package Repositories List:

   C:\ProgramData\Keysight\DigitalTestApps\Remote Toolkit\Version x\Tools\TAP\

   and click OK.

2. In the TAP PackageManager window, click the Packages tab, click on the "DigitalTest Apps API" entry in the list and click Install. Close the PackageManager.

3. In the TAP user interface, open Menu: View > Panels > Steps. The steps for controlling an automated test app will be located in the 'DigitalTest Apps API' tree.

See the help file, Keysight DigitalTestApps Remote Interface for TAP.chm, for a description of these steps.

The DigitalTest Apps API plugin includes two sample TAP test plans. After you install the plugin, the test plans will be located in:

C:\Program Files\Keysight\Test Automation\Packages\DigitalTest Apps API\*.TapPlan

Open these samples using the TAP user interface; then configure the steps' settings.

Both of these sample test plans are designed to control a sample automated test application generated by the Keysight D9010UDAA User Defined Application generator (license required). Installers for the sample UDAs may be found in the remote toolkit installation:

C:\ProgramData\Keysight\DigitalTestApps\Remote Toolkit\Version x\Tools\TAP\SetupUda_Application_TAP Xxx Demo_v#.exe

Execute these installers either on the PC where TAP is running or on an oscilloscope. If using an Infiniium oscilloscope, restart the measurement software to install the app into its menu system. Now you are ready to execute the sample
TAP test plans and watch them launch and control a UDA. If you add an SQLite listener, then after running tests, you can view the test results & settings the test plans published using a sample templates installed by the plugin here:

`C:\Program Files\Keysight\Test Automation\Packages\DigitalTest Apps API\*.TapReport`
The Automated Test Remote Scripting Language (ARSL)

Sometimes it is more convenient to access the automated test application remote interface using a textual syntax rather than the standard property/method call syntax. This is possible by using a command language called the Automated Test Engine (ATE) Remote Scripting Language, or “ARSL”. The ARSL Command Line Utility (described in "ARSL Command Line Utility" on page 18) takes advantage of this capability to present an easy-to-use textual interface to an automated test application.

The ARSL interface is implemented by using a method provided by the standard .NET remote interface: "ExecuteArsl()". This method takes one parameter: the textual remote interface command.

Here are some C# examples:

```csharp
// Get ATE remote interface object
IRemoteAte remoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);

// Perform the property query "ApplicationName"
string appName = remoteAte.ExecuteArsl("ApplicationName?");

// Perform the method call "SetConfig(variable,value)"
remoteAte.ExecuteArsl("SetConfig Speed Fast");
```

The argument in the ExecuteArsl call is the ARSL command. Remote interface members may be translated into ARSL using the following conversion rule map:

<table>
<thead>
<tr>
<th>Action</th>
<th>.NET Syntax</th>
<th>ARSL Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property query</td>
<td>var = PropertyName;</td>
<td>PropertyName?</td>
</tr>
<tr>
<td>Property set</td>
<td>PropertyName = val;</td>
<td>PropertyName val</td>
</tr>
<tr>
<td>Method call</td>
<td>MethodName(arg1,arg2)</td>
<td>MethodName arg1 arg2</td>
</tr>
</tbody>
</table>

In ARSL, property set and method call arguments are separated by spaces. If the argument contains reserved characters (spaces, single quotes, or double quotes), you must surround the value accordingly:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Legal ARSL formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ab</td>
<td>'Ab'</td>
</tr>
<tr>
<td>A b</td>
<td>'A b'</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Argument</th>
<th>Legal ARSL formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ab</td>
<td>&quot;Ab&quot;</td>
</tr>
<tr>
<td>A b</td>
<td>&quot;A b&quot;</td>
</tr>
</tbody>
</table>
You can also use ARSL to set properties whose types are custom types and to call methods that take custom type parameters:

```
PropertyName "property1=value;property2=value"
MethodName "property1=value;property2=value"
```

This technique results in the following:

1. An object of the type required by the property or method is created
2. The object is modified by setting the its specified properties to the specified values
3. The modified object is then used to set the property or is passed to the method.

The following examples should make this more clear:

### .NET Syntax
```
SomeOptions options = new SomeOptions();
options.Option1 = "a";
options.Option2 = "b";
remoteAte.Foo(options);
```

### ARSL Syntax
```
Foo Option1=a;Option2=b
```

The ARSL parser will automatically detect that Foo requires a parameter of type SomeOptions and will then construct one. It will then set the two specified properties on the SomeOptions object and finally pass this object as a parameter to the Foo method.

Note that, in this syntax, multiple property sets are separated by a semicolon. In the example above, the option set statements did not contain any spaces, so the pair did not need to be enclosed in quotes.

In the examples below, the option set statements contain a space and thus need to be enclosed in quotes:

```
Foo 'Option3=A b'
Foo "Option3=A b"
Foo "Option1=A b;Option2=c"
```

### Example Code

The following ARSL code snippets demonstrate property actions and method invocations:

<table>
<thead>
<tr>
<th>Argument</th>
<th>Legal ARSL formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>A'b</td>
<td>&quot;A'b&quot;</td>
</tr>
<tr>
<td>A&quot;b</td>
<td>'A&quot;b'</td>
</tr>
</tbody>
</table>
# Property actions
# ----------------

# Read the remote interface version
RemoteInterfaceVersion?

# Prevent these dialogs from displaying during run
SuppressSimpleMessages true

# Method invocations
# ------------------

# Set one of the application's user-configurable options
SetConfig speed fast

# Save the current configuration
SaveProject myProjectName

In addition, some property actions and method calls use custom types defined by the automated test application. Custom types are classes containing the required data. The following code snippets are examples of this:

# Custom property types
# ---------------------

# Query
ExistingResultsAction?

# Set
ConnectionPromptAction AutoRespond

# Custom types used in methods
# ----------------------------
SaveProjectCustom "Name=MyProject;BaseDirectory=d:\MyProjects;OverwriteExisting=true"

GetResults

Common Tasks

Here are common tasks you may want to perform in your programs. When there is more than one way to accomplish the task, alternatives are listed with a usage hint. For more information on each of the commands mentioned below, see the help file, "Keysight DigitalTestApps Remote Interface for .NET", located in the same directory as this programming guide.

- "Launching the automated test app" on page 47
- "Suppressing message prompts" on page 47

NOTE

If a method demonstrated below does not enable you to customize the action as desired, check the command help file to see if there is a similarly named "XxxCustom" method that provides more flexibility.
• “Configure settings found on the application’s 'Set Up' and 'Configure' tabs” on page 48
• “Select tests to be run” on page 48
• “Run Tests” on page 48
• “Get Results” on page 48
• “Save the project” on page 49
• “Start a new project” on page 49
• “Open a project” on page 49
• “Exiting the automated test app” on page 49

Launching the automated test app

• Manually. Use any time.
  Infiniium automated test apps: Use the oscilloscope menu: Analyze > Automated Test Apps > (AppName)
  FlexDCA automated test apps: Use the oscilloscope menu: Apps > Automated Test Apps > (AppName)
  Automated test apps: On your PC, launch the app using the Start menu or a shortcut.
• Using remote command. Send this SCPI command to Infiniium or FlexDCA:
  :SYSTEM:LAUNCH 'AppName'
  Where AppName is the name exactly as it appears in the menu system (see alternative above).

Suppressing message prompts

• Suppress "OK button" message prompts of type "Info", "Warning", or "Error". Use any time.
  SuppressSimpleMessages true
• Suppress "OK/Cancel button" messages that ask you to enter a value. Use only if the application has defined a default value for that prompt; otherwise test will be aborted.
  SuppressDataInputMessages true
• Suppress connection prompts. Use any time.
  ConnectionPromptAction AutoRespond
• Suppress "Signal Missing" prompts. Use any time.
  SignalCheckFailAction AutoRespond
• Suppress all of the above. See above for appropriate usage.
SuppressMessages true

Configure settings found on the application's 'Set Up' and 'Configure' tabs
SetConfig 'variableName1' 'value1'

Select tests to be run
- Select all of the tests currently shown on the application's 'Select Tests' tab. Use any time.
  SelectAllTests
- Select a subset of the available tests. Use any time.
  SelectedTests = 123,456,etc.

Run Tests
- With defaults. Use any time.
  Run
- With options. Use when you want to override the user preferences currently active in the target application.
  RunCustom 'StopRunIfTestAborts=true'

Get Results
- Quick overall result. Use any time.
  Passed?
- Get full details for all existing test results. Use any time.
  GetResults
- Get a subset of all available results. Use any time.
  GetResultsCustom 'TestIds=123,456;IncludeCsvData=true'
- CSV report. Use when you want CSV results in a separate file. File "results.csv" will be located inside the project.
  ExportResultsCsv
  SaveProject 'Project1'
- CSV text. Use when you want to see the CSV results on the remote client.
  GetResultsCustom 'IncludeCsvData=true'
- HTML Report.
  The .html file is located in the saved project.
Save the project

- Using default location property. Use when that location does not already have a project by the same name (although re-saves to the same location are allowed).
  
  ```
  SaveProject 'Project1'
  ```

- Using options. Use any time.

  ```
  SaveProjectCustom Name=Project1;BaseDirectory=c:\...\MyProjectDir;OverwriteExisting=true'
  ```

Start a new project

- Checking method. Use when you want to be warned when unsaved results exist.

  ```
  NewProject false
  ```

- Forced method. Use when you always want this command to complete (unsaved results will be discarded).

  ```
  NewProject true
  ```

Open a project

- Using default location. Use when you want to be warned when unsaved results exist.

  ```
  OpenProject 'Project1'
  ```

- Using options. Use any time.

  ```
  OpenProjectCustom 'FullPath=c:\...\MyProjectDir\Project1;DiscardUnsaved=true'
  ```

Exiting the automated test app

- Safer method. Use when you do not want to risk losing unsaved results (action will fail if unsaved results exist).

  ```
  Exit false true
  ```

- Forced method. Use when you always want this command to complete (unsaved results will be discarded).

  ```
  Exit true true
  ```

Example Program

```plaintext
SuppressMessages true
NewProject true
ExistingResultsAction Append
SelectedTests 123
Run
SaveProjectCustom 'Name=MyProjectName;OverwriteExisting=true'
```
Advanced Topic: Switch Matrix

The following ARSL code snippets demonstrate how to configure the Switch Matrix controller.

Using Automatic Mode

```arsl
SwitchMatrixOn true
SwitchMatrixSelectModeAuto 'Keysight U3020A S26'
SwitchMatrixConnectToInstrument 1 'lan[123.456.7890]:inst0'
```

If additional drivers were created by the app during execution of SwitchMatrixSelectModeAuto, simply execute SwitchMatrixConnectToInstrument again for each driver ID and instrument address. Each driver must be connected to a separate switch matrix instrument.

**NOTE**

Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

Using Manual Mode

```arsl
SwitchMatrixOn true
SwitchMatrixSelectModeManual
SwitchMatrixAddDriver 'Keysight U3020A S26'
SwitchMatrixConnectToInstrument 1 'lan[123.456.7890]:inst0'
```

To create an additional driver, simply add these lines:

```arsl
SwitchMatrixAddDriver 'Keysight U3020A S26'
SwitchMatrixConnectToInstrument 2 'lan[123.456.7890]:inst0'
```

Each driver must be connected to a separate switch matrix instrument.

**NOTE**

Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

Now you need to manually define each signal path, each one starting from the test point on the Device Under Test, through the switch, and ending with the scope channel.

Here is an example of a single-ended signal going into scope channel 3:

```arsl
```
SwitchMatrixDefineSignalPath 'CLK' 'Driver=1;Slot=1;Input=1' '3'

Here is an example of a differential signal going into a differential probe connected to scope channel 4:

SwitchMatrixDefineSignalPath 'Strobe+' 'Driver=1;Slot=1;Input=1' '4+'
SwitchMatrixDefineSignalPath 'Strobe-' 'Driver=1;Slot=2;Input=1' '4-'

Using Either Mode

All that remains is to assign a correction method to each signal path. This is optional but highly recommended.

Here is an example for one signal path that is using a single-ended probe:

SwitchMatrixSetPathPrecisionProbe 'CLK' '3' 'On=True;Mode=Probe;Calibration=MyCalName'

Here is an example for one signal path that is using a differential probe:

SwitchMatrixSetPathPrecisionProbe 'Strobe+' '4+' 'On=True;Mode=Probe;Calibration=MyCalName'

**NOTE**

With differential probes, you do not separately assign correction to the negative half of the signal.
Microsoft .NET

When you need to access the full capabilities of the remote interface, use a .NET programming language. This enables your programs to make use of conditional statements, looping, event subscriptions, return value analysis, and more.

Example Code

The following C# code snippets demonstrate property actions and method invocations:

// Property actions
// ---------------

// Read the remote interface version
string version = remoteApp.RemoteInterfaceVersion;

// Prevent these dialogs from displaying during run
remoteApp.SuppressSimpleMessages = true;

// Method invocations
// ------------------

// Set one of the applications user-configurable options
remoteApp.SetConfig("speed", "fast");

// Save the current configuration
string fullPath = remoteApp.SaveProject("myProject");

// Custom property types
// ----------------------

// Query
ExistingResultsAction action = remoteApp.ExistingResultsAction;

// Set
remoteApp.ConnectionPromptAction = CustomPromptAction.AutoRespond;

// Custom types used in methods.
SaveProjectOptions options = new SaveProjectOptions();
options.Name = "MyProject";
options.BaseDirectory = "d:\MyProjects";
options.OverwriteExisting = true;
string fullPath = remoteApp.SaveProjectCustom(options);

ResultContainer results = remoteApp.GetResults();
MeasurementResult worstResult = results.WorstResults[0];
Common Tasks

Here are common tasks you may want to perform in your programs. When there is more than one way to accomplish the task, alternatives are listed with a usage hint. For more information on each of the commands mentioned below, see the help file, "Keysight DigitalTestApps Remote Interface for .NET", located in the same directory as this programming guide.

**NOTE**

If a method demonstrated below does not enable you to customize the action as desired, check the command help file to see if there is a similarly named "XxxCustom" method that provides more flexibility.

- "Launching the automated test app" on page 53
- "Suppressing message prompts" on page 54
- "Configure settings found on the application's 'Set Up' and 'Configure' tabs" on page 54
- "Select tests to be run" on page 54
- "Run Tests" on page 54
- "Get Results" on page 54
- "Save the project" on page 55
- "Start a new project" on page 55
- "Open a project" on page 56
- "Exiting the automated test app" on page 56

**Launching the automated test app**

- Manually. Use any time.
  
  Infiniium automated test apps: Use the oscilloscope menu: **Analyze > Automated Test Apps > (AppName)**
  
  FlexDCA automated test apps: Use the oscilloscope menu: **Apps > Automated Test Apps > (AppName)**
  
  Automated test apps: On your PC, launch the app using the Start menu or a shortcut.
- Using remote command. Send this SCPI command to Infiniium or FlexDCA:
  
  ```scpi
  :SYSTEM:LAUNCH 'AppName'
  ```
  
  Where AppName is the name exactly as it appears in the menu system (see alternative above).
Suppressing message prompts

- Suppress "OK button" message prompts of type "Info", "Warning", or "Error". Use any time.
  ```csharp
  remoteAte.SuppressSimpleMessages = true;
  ```
- Suppress "OK/Cancel button" messages that ask you to enter a value. Use only if the application has defined a default value for that prompt; otherwise test will be aborted.
  ```csharp
  remoteAte.SuppressDataInputMessages = true;
  ```
- Suppress connection prompts. Use any time.
  ```csharp
  remoteAte.ConnectionPromptAction = CustomPromptAction.AutoRespond;
  ```
- Suppress "Signal Missing" prompts. Use any time.
  ```csharp
  remoteAte.SignalCheckFailAction = CustomPromptAction.AutoRespond;
  ```
- Suppress all of the above. See above for appropriate usage.
  ```csharp
  remoteAte.SuppressMessages = true;
  ```

Configure settings found on the application's 'Set Up' and 'Configure' tabs

```csharp
remoteAte.SetConfig("variableName1", "value1");
```

Select tests to be run

- Select all of the tests currently shown on the application's 'Select Tests' tab. Use any time.
  ```csharp
  remoteAte.SelectAllTests();
  ```
- Select a subset of the available tests. Use any time.
  ```csharp
  remoteAte.SelectedTests = new int[]{123, 456, etc.};
  ```

Run Tests

- With defaults. Use any time.
  ```csharp
  remoteAte.Run();
  ```
- With options. Use when you want to override the user preferences currently active in the target application.
  ```csharp
  RunOptions options = new RunOptions();
  options.StopRunIfTestAborts = true;
  remoteAte.RunCustom(options);
  ```

Get Results

- Quick overall result. Use any time.
  ```csharp
  bool passed = remoteAte.Passed;
  ```
• Get full details for all existing test results. Use any time.
  
  ResultContainer results = remoteAte.GetResults();

• Get a subset of all available results. Use any time.
  
  ResultOptions options = new ResultOptions();
  options.TestIds = new int[]{123, 456};
  remoteAte.GetResultsCustom(options);

• CSV report. Use when you want CSV results in a separate file. File "results.csv"
  will be located inside the project.
  
  remoteAte.ExportResultsCsv();
  remoteAte.SaveProject("Project1");

• CSV text. Use when you want to see the CSV results on the remote client.
  
  ResultOptions options = new ResultOptions();
  options.TestIds = new int[]{123, 456};
  options.IncludeCsvData = true;
  remoteAte.GetResultsCustom(options);

• HTML Report.
  
  The .html file is located in the saved project.

Save the project

• Using default location property. Use when that location does not already have a
  project by the same name (although re-saves to the same location are allowed).
  Otherwise, save will be aborted.
  
  remoteAte.SaveProject("Project1");

• Using options. Use any time.
  
  SaveProjectOptions options = new SaveProjectOptions();
  options.Name = "Project1";
  options.BaseDirectory = @"c:\...\MyProjectDir";
  options.OverwriteExisting = true;
  remoteAte.SaveProjectCustom (options);

Start a new project

• Checking method. Use when you want to be warned when unsaved results
  exist.
  
  remoteAte.NewProject(false);

• Forced method. Use when you always want this command to complete
  (unsaved results will be discarded).
  
  remoteAte.NewProject(true);
Open a project

- Using default location. Use when you want to be warned when unsaved results exist.

    remoteAte.OpenProject("Project1");

- Using options. Use any time.

    OpenProjectOptions options = new OpenProjectOptions();
    options.FullPath = "c:\..\MyProjectDir\Project1";
    options.DiscardUnsaved = true;
    remoteAte.OpenProjectCustom(options);

Exiting the automated test app

- Safer method. Use when you do not want to risk losing unsaved results (action will fail if unsaved results exist).

    remoteAte.Exit(false, true);

- Forced method. Use when you always want this command to complete (unsaved results will be discarded).

    remoteAte.Exit(true, true);

Example Programs

The following example:

1. Loads an existing project.
2. Executes multiple tests one at a time, giving you an opportunity to modify the device under test in between tests.
3. At the end of the run, saves the resulting project.
4. Exports the tests results to a .csv file for post processing.

using System;
using System.IO;

...  
IRemoteAte remoteAte =
    RemoteAteUtilities.GetRemoteAte("123.45.67.890");
remoteAte.SuppressMessages = true;

// TODO: Read/write share directory "c:\Automated Test Apps" on the
// PC that will be running this automation program (directory name
// is arbitrary).
const string baseDirectory = "Automated Test Apps";

// Tell the app to load the starting project from the PC this
// automation program is running on.
OpenProjectOptions openProjectOptions = new OpenProjectOptions();
openProjectOptions.DiscardUnsaved = true;
openProjectOptions.FullPath = "\\\MyPCName\" + baseDirectory +

"\DDR3\Base Project\Base Project.proj";
remoteAte.OpenProjectCustom(openProjectOptions);

// Run the first test
remoteAte.SelectedTests = new int[] {123};
remoteAte.Run();

// Modify DUT/switch, etc. here

// Run the second test
// This unselects test 123.
remoteAte.SelectedTests = new int[] {456};
// This appends 456 results to the existing results for test 123.
remoteAte.Run();

// Tell the app to save the entire project to the PC this automation
// program is running on.
SaveProjectOptions saveProjectOptions = new SaveProjectOptions();
saveProjectOptions.BaseDirectory = "\\MyPCName\\" + baseDirectory + "\\DDR3";
saveProjectOptions.Name = "My DDR3 Device";
saveProjectOptions.OverwriteExisting = true;
remoteAte.SaveProjectCustom(saveProjectOptions);

// Export CSV results.
ResultOptions resultOptions = new ResultOptions();
resultOptions.IncludeCsvData = true;
ResultContainer resultContainer =
    remoteAte.GetResultsCustom(resultOptions);
StreamWriter writer = null;
try{
    // Because this file is being created by this automation program
    // which is running on the PC, use the local, not network, path.
    // For convenience sake, this example saves it to the directory
    // which contains the entire project; file name is arbitrary.
    writer = new StreamWriter("c:\" + baseDirectory + "\DDR3\" +
        saveProjectOptions.Name + "\AllResults.csv");
    writer.WriteLine(resultContainer.CsvResults);
}
finally{
    if (writer != null) writer.Close();
}

...
Advanced Topic: Event Handling

The above examples demonstrate how to use the "forward facing" (remote client \(\rightarrow\) automated test application) direction of the remote interface. The remote interface also has a "callback" (automated test application \(\rightarrow\) remote client) direction, described in "Keysight.DigitalTestApps.Framework.Remote.Advanced" on page 14. A sample implementation using this capability can be found in: "Message Handling Remote Client Implementation" on page 100.

Advanced Topic: Switch Matrix

The following C# code snippets demonstrate how to configure the Switch Matrix controller.

Using Automatic Mode

```csharp
remoteAte.SwitchMatrixOn = true;
remoteAte.SwitchMatrixSelectModeAuto("Keysight U3020A S26");
remoteAte.SwitchMatrixConnectToInstrument(1, "lan[123.456.7890]:inst0");
```

If additional drivers were created by the app during execution of `SwitchMatrixSelectModeAuto`, simply execute `SwitchMatrixConnectToInstrument` again for each driver ID and instrument address. Each driver must be connected to a separate switch matrix instrument.

**NOTE**

Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

Using Manual Mode

```csharp
remoteAte.SwitchMatrixOn = true;
remoteAte.SwitchMatrixSelectModeManual();
remoteAte.SwitchMatrixAddDriver("Keysight U3020A S26");
remoteAte.SwitchMatrixConnectToInstrument(1,"lan[123.456.7890]:inst0");
```

To create an additional driver, simply add these lines:

```csharp
remoteAte.SwitchMatrixAddDriver("Keysight U3020A S26");
remoteAte.SwitchMatrixConnectToInstrument(2,"lan[123.456.7890]:inst0");
```

Each driver must be connected to a separate switch matrix instrument.

**NOTE**

Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

Now you need to manually define each signal path, each one starting from the test point on the Device Under Test, through the switch, and ending with the scope channel.
Here is an example of a single-ended signal going into scope channel 3:

```csharp
SwitchInfo info = new SwitchInfo();
info.Driver = 1;
info.Slot = 1;
info.Input = 1;
remoteAte.SwitchMatrixDefineSignalPath("CLK", info,"3");
```

Here is an example of a differential signal going into a differential probe connected to scope channel 4:

```csharp
SwitchInfo info = new SwitchInfo();
info.Driver = 1;
info.Slot = 1;
info.Input = 1;
remoteAte.SwitchMatrixDefineSignalPath("Strobe+",info,"4+");
info = new SwitchInfo();
info.Driver = 1;
info.Slot = 2;
info.Input = 1;
remoteAte.SwitchMatrixDefineSignalPath("Strobe-",info,"4-");
```

**Using Either Mode**

All that remains is to assign a correction method to each signal path. This is optional but highly recommended.

Here is an example for one signal path that is using a single-ended probe:

```csharp
PrecisionProbeOptions options = new PrecisionProbeOptions();
options.On = true;
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe;
options.Calibration = "MyCalName";
remoteAte.SwitchMatrixSetPathPrecisionProbe("CLK", "3", options);
```

Here is an example for one signal path that is using a differential probe:

```csharp
PrecisionProbeOptions options = new PrecisionProbeOptions();
options.On = true;
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe;
options.Calibration = "MyCalName";
remoteAte.SwitchMatrixSetPathPrecisionProbe("Strobe+","4+",options);
```

**NOTE**

With differential probes, you do not separately assign correction to the negative half of the signal.

**Advanced Topic: Parallel Testing**

To accelerate testing of multiple devices, you may control multiple automated test applications (running on different scopes) in parallel using the multi-threading capabilities available in .NET. For example:

```csharp
public void DoMultiScopeTesting()
{
```
Thread t1 = _StartTestingOnScope("<IP address 1>");
Thread t2 = _StartTestingOnScope("<IP address 2>");
t1.Join();
t2.Join();
}

private Thread _StartTestingOnScope(string ipAddress)
{
    var t = new Thread(() => _Execute(ipAddress));
    t.Start();
    return t;
}

private static void _Execute(string ipAddress)
{
    IRemoteAte remoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);
    ...
}

This program will let both automated test applications run without waiting for each other. The calls to _StartTestingOnScope are not blocking, so the program starts both apps running and then proceeds to the first Join statement, where it waits for the first app to complete. Then, the program moves on to the second Join where it waits for the second app to complete (it's okay if it finished first).

**NOTE**
This solution requires .NET 3.5 or newer on the remote client. Multi-threading is also possible with older .NET versions using less robust techniques.
Python

You can combine the ease of text-based programming with the depth of the .NET API by choosing an interpreted language with .NET compatibility, such as CPython. By installing the Pythonnet package, you gain access to the power of multi-paradigm programming: You can choose to write traditional "function call" code utilizing the .NET API or you can choose to write SCPI-like "text-based" code which takes advantage of the ARSL syntax. Both of these are demonstrated below.

Furthermore, using the Python Visa package, you can even launch the automated test app from the same script that controls it.

Using the Python Visa Package

The Python VISA package, or PyVISA, is free open source software available from: http://pyvisa.sourceforge.net/. When you install this package you will be able to connect to an Keysight oscilloscope or FlexDCA and launch an automated test application using code as simple as:

```python
import visa
infiniium = visa.instrument("<VISA>")
# Where <VISA> is the VISA address of the oscilloscope, for example,
# visa.instrument("TCPIP0::123.45.67.890::inst0:INSTR")
infiniium.write(":SYSTEM:LAUNCH '<application name>'")
# Where <application name> is the exact text that appears in the
# scope or FlexDCA applications menu, for example,
# infiniium.write(":SYSTEM:LAUNCH 'N5393C PCIExpress Test App'")
```

Using the Python for .NET Package

The Python for .NET package is free open source software available from: https://pypi.org/project/pythonnet/. When you install this package, you will be able to connect to and control a launched Keysight automated test application using code as simple as:

```python
import clr
from Keysight.DigitalTestApps.Framework.Remote import *
remoteObj = RemoteAteUtilities.GetRemoteAte("<ip>")
# Where <ip> is the oscilloscope's IP address, for example,
# RemoteAteUtilities.GetRemoteAte("123.45.67.890")
remoteApp = IRemoteAte(remoteObj)
remoteApp.<method or property>
# Where <method or property> is any method or property found in
# the application's .NET interface, described in Chapter 1.
# For example,
# remoteApp.Run()
```

To make this work, you need to copy a few files to your Python installation directory.
If you are using Python 2.7.x:

1. First copy these files from the Keysight N5452A Remote Toolkit "Tools" folder to c:\Python27\DLLs:

2. Next, download the 32-or 64-bit *cp27*.whl file from https://pypi.org/project/pythonnet/#files and execute this in a command window to install it:
   ```
   pip install downloaded_file.whl
   ```
   This will install these two files into C:\Python27\DLLs:
   - clr.pyd
   - Python.Runtime.dll

If you are using Python 3.7.x:

1. First copy these files from the Keysight N5452A Remote Toolkit "Tools" folder to C:\Users\<your user name>\AppData\Local\Programs\Python\Python37\DLLs:

2. Next, execute this in a command window:
   ```
   pip install Pythonnet
   ```
   This will download and execute the latest *cp37*.whl to copy these two files into C:\Users\<your user name>\AppData\Local\Programs\Python\Python37\Lib\site-packages:
   - clr.pyd
   - Python.Runtime.dll

**NOTE**
Be sure to keep the clr.pyd and Python.Runtime.dll files together in the same directory.

---

**Example Code**

The following Python code snippets demonstrate property actions and method invocations:

```python
# Property actions
# ----------------
# Read the remote interface version
version = remoteApp.RemoteInterfaceVersion
# Prevent these dialogs from displaying during run
remoteApp.SuppressSimpleMessages = True
```
# Method invocations
# ------------------
# Set one of the applications user-configurable options
remoteApp.SetConfig("speed", "fast")
# Save the current configuration
fullPath = remoteApp.SaveProject("myProject")

# Custom property types
# ---------------------
# Query
action = remoteApp.ExistingResultsAction
# Set
remoteApp.ConnectionPromptAction = CustomPromptAction.AutoRespond
# Custom types used in methods.
options = SaveProjectOptions()
options.Name = "MyProject"
options.BaseDirectory = "d:\\MyProjects"
options.OverwriteExisting = True
fullPath = remoteApp.SaveProjectCustom(options)
results = remoteApp.GetResults()
extremeResult = results.ExtremeResults[0];

The following Python code snippets demonstrate the equivalent actions using SCPI-like ARSL-formatted strings:

# Property actions
# ----------------
# Read the remote interface version
version = remoteApp.ExecuteArsl("RemoteInterfaceVersion?")
remoteApp.ExecuteArsl("SuppressSimpleMessages True")

# Method invocations
# ------------------
# Set one of the applications user-configurable options
remoteApp.ExecuteArsl("SetConfig 'speed' 'fast'")
# Save the current configuration
fullPath = remoteApp.ExecuteArsl("SaveProject 'myProject'")

# Custom property types
# ---------------------
# Query
action = remoteApp.ExecuteArsl("ExistingResultsAction?")
# Set
remoteApp.ExecuteArsl("ConnectionPromptAction AutoRespond")
# Custom types used in methods.
fullPath = remoteApp.ExecuteArsl("SaveProjectCustom " + \
  "'Name=MyProject;BaseDirectory=" + \
  "d:\\MyProjects;OverwriteExisting=True'")
results = remoteApp.ExecuteArsl("GetResults")
Common Tasks

Here are common tasks you may want to perform in your programs. When there is more than one way to accomplish the task, alternatives are listed with a usage hint. Both method call and ARSL-formatted text paradigms are presented. For more information on each of the commands mentioned below, see the help file, "Keysight DigitalTestApps Remote Interface for .NET", located in the same directory as this programming guide.

**NOTE**

If a method demonstrated below does not enable you to customize the action as desired, check the command help file to see if there is a similarly named "XxxCustom" method that provides more flexibility.

- "Launching the automated test app" on page 64
- "Suppressing message prompts" on page 65
- "Configure settings found on the application's 'Set Up' and 'Configure' tabs" on page 65
- "Select tests to be run" on page 66
- "Run Tests" on page 66
- "Get Results" on page 66
- "Save the project" on page 68
- "Start a new project" on page 68
- "Open a project" on page 68
- "Exiting the automated test app" on page 69

### Launching the automated test app

- Manually. Use any time.
  
  Infiniium automated test apps: Use the oscilloscope menu: **Analyze > Automated Test Apps > (AppName)**
  
  FlexDCA automated test apps: Use the oscilloscope menu: **Apps > Automated Test Apps > (AppName)**
  
  Automated test apps: On your PC, launch the app using the Start menu or a shortcut.

- Using remote command. Send this SCPI command to Infiniium or FlexDCA:
  
  ```scpi
  :SYSTEM:LAUNCH 'AppName'
  ```
  
  Where AppName is the name exactly as it appears in the menu system (see alternative above).
Suppressing message prompts

- Suppress "OK button" message prompts of type "Info", "Warning", or "Error". Use any time.
  Method call:
  ```
  remoteApp.SuppressSimpleMessages = True
  ```
  Text:
  ```
  remoteApp.ExecuteArsl("SuppressSimpleMessages True")
  ```

- Suppress "OK/Cancel button" messages that ask you to enter a value. Use only if the application has defined a default value for that prompt; otherwise test will be aborted.
  Method call:
  ```
  remoteApp.SuppressDataInputMessages = True
  ```
  Text:
  ```
  remoteApp.ExecuteArsl("SuppressDataInputMessages True")
  ```

- Suppress connection prompts. Use any time.
  Method call:
  ```
  remoteApp.ConnectionPromptAction = CustomPromptAction.AutoRespond
  ```
  Text:
  ```
  remoteApp.ExecuteArsl("ConnectionPromptAction AutoRespond")
  ```

- Suppress "Signal Missing" prompts. Use any time.
  Method call:
  ```
  remoteApp.SignalCheckFailAction = CustomPromptAction.AutoRespond
  ```
  Text:
  ```
  remoteApp.ExecuteArsl("SignalCheckFailAction AutoRespond")
  ```

- Suppress all of the above. See above for appropriate usage.
  Method call:
  ```
  remoteApp.SuppressMessages = True
  ```
  Text:
  ```
  remoteApp.ExecuteArsl("SuppressMessages True")
  ```

Configure settings found on the application's 'Set Up' and 'Configure' tabs

Method call:
```
remoteApp.SetConfig("variableName1", "value1")
```
Text:
remoteApp.ExecuteArsl("SetConfig 'variableName1' 'value1'")

Select tests to be run

• Select all of the tests currently shown on the application's 'Select Tests' tab. Use any time.
  Method call:
  remoteApp.SelectAllTests()
  Text:
  remoteApp.ExecuteArsl("SelectAllTests")

• Select a subset of the available tests. Use any time.
  Method call:
  remoteApp.SelectedTests = [123,456,etc.]
  Text:
  remoteApp.ExecuteArsl("SelectedTests 123,456,etc.")

Run Tests

• With defaults. Use any time.
  Method call:
  remoteApp.Run()
  Text:
  remoteApp.ExecuteArsl("Run")

• With options. Use when you want to override the user preferences currently active in the target application.
  Method call:
  runOptions = RunOptions()
  runOptions.StopRunIfTestAborts = True
  remoteApp.RunCustom(runOptions)
  Text:
  remoteApp.ExecuteArsl("RunCustom 'StopRunIfTestAborts=True'")

Get Results

• Quick overall result. Use any time.
  Method call:
  passed = remoteAte.Passed
Text:
remoteApp.ExecuteArsl("Passed?")

- Get full details for all existing test results. Use any time.

Method call:
results = remoteAte.GetResults()

Text:
remoteApp.ExecuteArsl("GetResults")

- Get a subset of all available results. Use any time.

Method call:
resultOptions = ResultOptions()
resultOptions.TestIds = [123, 456]
remoteApp.GetResultsCustom(resultOptions)

Text:
remoteApp.ExecuteArsl("GetResultsCustom 'TestIds=123,456'")

- CSV report. Use when you want CSV results in a separate file. File "results.csv" will be located inside the project.

Method call:
remoteApp.ExportResultsCsv()
remoteApp.SaveProject("Project1")

Text:
remoteApp.ExecuteArsl("ExportResultsCsv")
remoteApp.ExecuteArsl("SaveProject 'Project1'")

- CSV text. Use when you want to see the CSV results on the remote client.

Method call:
resultOptions = ResultOptions()
resultOptions.TestIds = [123, 456]
resultOptions.IncludeCsvData = True
remoteApp.GetResultsCustom(resultOptions)

Text:
remoteApp.ExecuteArsl("GetResultsCustom 'TestIds=123,456;IncludeCsvData=True'")

- HTML Report.

The .html file is located in the saved project.
Save the project

• Using default location property. Use when that location does not already have a project by the same name (although re-saves to the same location are allowed). Otherwise, save will be aborted.

Method call:

remoteApp.SaveProject("Project1")

Text:

remoteApp.ExecuteArsl("SaveProject 'Project1'")

• Using options. Use any time.

Method call:

saveProjectOptions = SaveProjectOptions()
saveProjectOptions.Name = "Project1"
saveProjectOptions.BaseDirectory = "c:\...\MyProjectDir"
saveProjectOptions.OverwriteExisting = True
remoteApp.SaveProjectCustom(saveProjectOptions)

Text:

remoteApp.ExecuteArsl("SaveProjectCustom 'Name=Project1;BaseDirectory =c:\...\MyProjectDir;OverwriteExisting=True'")

Start a new project

• Checking method. Use when you want to be warned when unsaved results exist.

Method call:

remoteApp.NewProject(False)

Text:

remoteApp.ExecuteArsl("NewProject False")

• Forced method. Use when you always want this command to complete (unsaved results will be discarded).

Method call:

remoteApp.NewProject(True)

Text:

remoteApp.ExecuteArsl("NewProject True")

Open a project

• Using default location. Use when you want to be warned when unsaved results exist.
Method call:
remoteApp.OpenProject("Project1")

Text:
remoteApp.ExecuteArsl("OpenProject 'Project1'")

• Using options. Use any time.

Method call:
openProjectOptions = OpenProjectOptions()
openProjectOptions.FullPath = "c:\...\MyProjectDir\Project1"
openProjectOptions.DiscardUnsaved = True
remoteApp.OpenProjectCustom(openProjectOptions)

Text:
remoteApp.ExecuteArsl("OpenProjectCustom 'FullPath=c:\...\MyProjectDir\Project1;DiscardUnsaved=True'")

Exiting the automated test app

• Safer method. Use when you do not want to risk losing unsaved results (action will fail if unsaved results exist).

Method call:
remoteApp.Exit(False, True)

Text:
remoteApp.ExecuteArsl("Exit False True")

• Forced method. Use when you always want this command to complete (unsaved results will be discarded).

Method call:
remoteApp.Exit(True, True)

Text:
remoteApp.ExecuteArsl("Exit True True")

Example Programs

The following example:

1 Launches the DDR3 automated test application.
2 Loads an existing project.
3 Executes multiple tests one at a time, giving you an opportunity to modify the device under test in between tests.
4 At the end of the run, saves the resulting project.
5 Exports the tests results to a .csv file for post processing.
The example is presented in both method call and text paradigms.

**Using Method Calls**

```
    """Import the compiled Python Visa module"
    import visa

    """Connect to the scope"
    remoteScope = visa.instrument("enter scope's VISA address here")

    """Launch the DDR3 application"
    remoteScope.write(":SYSTEM:LAUNCH 'DDR3 Test'

    """Import the compiled Pythonnet module"
    import clr

    """Import the Keysight automated test app remote library DLL"
    from Keysight.DigitalTestApps.Framework.Remote import *

    """Connect to the automated test application running on the scope
    This will wait for the application to be fully launched and ready
    before proceeding"
    scopeIpAddress = "123.45.67.890"
    remoteObj = RemoteAteUtilities.GetRemoteAte(scopeIpAddress)
    remoteApp = IRemoteAte(remoteObj)

    """Prevent dialogs from displaying during the run"
    remoteApp.SuppressMessages = True

    """Ensure app settings are in a known state"
    remoteApp.NewProject(True)

    """Select the tests to be run
    Use commas to separate multiple IDs"
    remoteApp.SelectedTests = [50000]

    """Set a variable found on the app's 'Configure' tab
    Get variable name and valid options from app's remote help file
    or from GUI hints"
    remoteApp.SetConfig("TrigChan", "CHAN4")

    """Start the run. This is a blocking call...
    program will wait until app is finished"
    remoteApp.Run()

    """Save the project"
    saveOptions = SaveProjectOptions()
    saveOptions.BaseDirectory = "c:\\temp"
    saveOptions.Name = "Demo"
    saveOptions.OverwriteExisting = True
    projectFullPath = remoteApp.SaveProjectCustom(saveOptions)
    print projectFullPath

    """This will print the extreme results to the console window
    in which this script is running"
    results = remoteApp.GetResults()
```
Remote Programming Languages and Sample Code

```python
resultOptions = ResultOptions()
resultOptions.TestIds = [123]
resultOptions.IncludeCsvData = True
customResults = remoteApp.GetResultsCustom(resultOptions)
print customResults.CsvResults

import visa
remoteScope = visa.instrument("enter scope's VISA address here")
remoteScope.write(':SYSTEM:LAUNCH DDR3 Test')

import clr
from Keysight.DigitalTestApps.Framework.Remote import *
scopeIpAddress = "123.45.67.890"
remoteObj = RemoteAteUtilities.GetRemoteAte(scopeIpAddress)
remoteApp = IRemoteAte(remoteObj)
remoteApp.ExecuteArsl("SuppressMessages True")
remoteApp.ExecuteArsl("NewProject True")
remoteApp.ExecuteArsl("SelectedTests 123")
remoteApp.ExecuteArsl("SetConfig 'TrigChan' 'CHAN4'")
remoteApp.ExecuteArsl("Run")
print remoteApp.ExecuteArsl("SaveProjectCustom 'BaseDirectory=' + c:\temp;Name='Demo';OverwriteExisting=True")
```
this script is running.
print remoteApp.ExecuteArs1("GetResults")

"""This will get all results in csv format."""
print remoteApp.ExecuteArs1("GetResultsCustom " + 
  "'TestIds=50000;IncludeCsvData=True'")

See Chapter 1, "Remote Interface Documentation" on page 10, for more information on getting your application’s test IDs.

Advanced Topic: Event Handling

The above examples demonstrate how to use the "forward facing" (remote client -> automated test application) direction of the remote interface. The remote interface also has a "callback" (automated test application -> remote client) direction, described here "Keysight.DigitalTestApps.Framework.Remote.Advanced" on page 14. A sample implementation using this capability follows.

The Python script shown below accomplishes the following tasks:

• Connects to an automated test application.
• Establishes the callback pipe.
• Redirects messages (prompts) to the remote client machine.
• Programmatically responds to a message (without displaying it).

"""Import the compiled Pythonnet module"""
import clr

"""Import .NET types"""
from System.Runtime.Remoting import *
from System.Windows.Forms import *

"""Import the Keysight automated test app remote library DLL"""
from Keysight.DigitalTestApps.Framework.Remote import *

"""Define the event callback handler""
def SimpleMessageEventHandler(source, args):
  print 'Received message: ' + args.Message

  """Check for 'Run Ended' message using stable message ID
  (available in Remote Interface Version 2.80 and later,
  find IDs in app’s Remote_Prog_Ref.chm)""
  if args.ID == "602F9866-F975-42b7-842C-D8447E5E3FCB":
    args.Response = DialogResult.OK
  else:
    print 'Message not handled'

NOTE
Replace "123.45.67.890" with the actual IP address of the oscilloscope running your automated test application, and replace "123" with an actual test ID for the application.
For Remote Interface Version 2.70 and older, must parse args.Message property text to determine this is 'Run Ended' message

For example:

```
if args.Message.find("All selected tests completed") >= 0:
```

Connect to the automated test application running on the scope
This will wait for the application to be fully launched and ready
before proceeding
```python
cscopeIpAddress = "123.45.67.890"
remoteObj = RemoteAteUtilities.GetRemoteAte(scopeIpAddress)
remoteApp = IRemoteAte(remoteObj)
```

Verify Connection
```python
print remoteApp.ApplicationName
```

Establish callback path
```python
configFileFullPath = "c:\Python27\DLLs\Keysight.DigitalTestApps.Framework.Remote.config";
RemotingConfiguration.Configure(configFileFullPath, False);
eventSink = RemoteAteUtilities.CreateAteEventSink(remoteApp, None, scopeIpAddress)
```

Subscribe to message events
```python
eventSink.RedirectMessagesToClient = True
eventSink.SimpleMessageEvent += SimpleMessageEventHandler
```

Run tests
```python
try:
    remoteApp.SelectedTests = [123]
    remoteApp.Run()
except Exception, e:
    print e.Message
```

Unsubscribe from message events and clean up
```python
eventSink.SimpleMessageEvent -= SimpleMessageEventHandler
eventSink.Dispose()
```

Replace "c:\Python27\DLLs\" with the actual location of the configuration file, replace "123.45.67.890" with the actual IP address of the oscilloscope running your automated test application, and replace "123" with an actual test ID for the application.

Compliance apps generate messages having Unicode encoding. Therefore, if you print messages received from the automated test application you may encounter a UnicodeEncodeError exception if the messages contain certain characters, for example, single quote characters U+2018 and U+2019. Please see your Python documentation for instructions on how to handle Unicode text.
Tips:

1. Use of the remote interface's callback path requires a .NET Remoting configuration file, Keysight.DigitalTestApps.Framework.Remote.config, which contains settings for the callback pipe. This file may be found in the remote toolkit in the Tools subdirectory.

2. The example script only handles the prompt that appears at the end of a run, because of this line:

   ```python
   if args.Message.find("All selected tests completed") >= 0:
   ```

   To handle other prompts, add another case to the function, for example:

   ```python
   if args.Message.find("All selected tests completed") >= 0:
       args.Response = DialogResult.OK
   elif args.Message.find("Some other message") >= 0:
       args.Response = DialogResult.Yes
   else:
       print 'Message not handled'
   ```

   Replace "Yes" with the actual name of a button that appears on the prompt.

---

Note that code located inside an automated test app event handler, such as the SimpleMessageEventHandler, is executing in a "dummy" thread, which are threads of control started outside the Python threading module that have limited functionality. Certain actions cannot succeed inside a dummy thread, such as making a DDE (Dynamic Data Exchange) call. To handle this limitation, you need to use a mechanism that can reassign such actions to Python's main thread.

The remote toolkit contains a class named CrossThreadFunctionInvoker that enables you to do this, along with two programs that demonstrate usage of the class. These are contained in the Source\Python subdirectory:

<table>
<thead>
<tr>
<th>File</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CrossThreadFunctionInvoker.py</td>
<td>Contains the CrossThreadFunctionInvoker class and a simple program to demonstrate its usage</td>
</tr>
<tr>
<td>CrossThreadFunctionInvokerAppExample.py</td>
<td>Contains a sample automated test app automation program that uses the CrossThreadFunctionInvoker class</td>
</tr>
</tbody>
</table>

Advanced Topic: Switch Matrix

The following Python code snippets demonstrate how to configure the Switch Matrix controller.
Using Automatic Mode

remoteApp.SwitchMatrixOn = True
remoteApp.SwitchMatrixSelectModeAuto("Keysight U3020A S26")
remoteApp.SwitchMatrixConnectToInstrument(1, "lan[123.456.7890]:inst0")

If additional drivers were created by the app during execution of SwitchMatrixSelectModeAuto, simply execute SwitchMatrixConnectToInstrument again for each driver ID and instrument address. Each driver must be connected to a separate switch matrix instrument.

NOTE
Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

Using Manual Mode

remoteApp.SwitchMatrixOn = True
remoteApp.SwitchMatrixSelectModeManual()
remoteApp.SwitchMatrixAddDriver("Keysight U3020A S26")
remoteApp.SwitchMatrixConnectToInstrument(1,"lan[123.456.7890]:inst0")

To create an additional driver, simply add these lines:

remoteApp.SwitchMatrixAddDriver("Keysight U3020A S26");
remoteApp.SwitchMatrixConnectToInstrument(2,"lan[123.456.7890]:inst0")

Each driver must be connected to a separate switch matrix instrument.

NOTE
Replace 123.456.7890 with the full SICL address or VISA alias of your switch instrument.

Now you need to manually define each signal path, each one starting from the test point on the Device Under Test, through the switch, and ending with the scope channel.

Here is an example of a single-ended signal going into scope channel 3:

info = SwitchInfo()
info.Driver = 1
info.Slot = 1
info.Input = 1
remoteApp.SwitchMatrixDefineSignalPath("CLK",info,"3")

Here is an example of a differential signal going into a differential probe connected to scope channel 4:

info = SwitchInfo()
info.Driver = 1
info.Slot = 1
info.Input = 1
remoteApp.SwitchMatrixDefineSignalPath("Strobe+",info,"4+")
info = SwitchInfo()
info.Driver = 1
info.Slot = 2
info.Input = 1
remoteApp.SwitchMatrixDefineSignalPath("Strobe-",info,"4-")

Using Either Mode

All that remains is to assign a correction method to each signal path. This is optional but highly recommended.

Here is an example for one signal path that is using a single-ended probe:

```python
options = PrecisionProbeOptions()
options.On = True
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe
options.Calibration = "MyCalName"
remoteApp.SwitchMatrixSetPathPrecisionProbe("CLK", "3", options)
```

Here is an example for one signal path that is using a differential probe:

```python
options = PrecisionProbeOptions()
options.On = True
options.Mode = PrecisionProbeOptions.PrecisionProbeMode.Probe
options.Calibration = "MyCalName"
remoteApp.SwitchMatrixSetPathPrecisionProbe("Strobe+","4+",options)
```

NOTE

With differential probes, you do not separately assign correction to the negative half of the signal.
4 Recommended Remote Programming Practices

Determine required tasks by first using the graphical user interface / 78
Verify the remote commands one at a time / 79
Check the log / 80
Determine required tasks by first using the graphical user interface

Before you write remote programming code to perform a task, it is often best to begin by determining the steps required to execute the task via the user interface on the oscilloscope. This will often help you avoid problems caused by incorrect step sequencing.

For example, automated test applications often manage large list of tests by providing a test filter. This is usually presented as a radio button group on the "Set Up" tab that determines which tests are visible on the "Select Tests" tab. Suppose these were your options:

"Set Up" tab:
- Speed: o Low o High

Imagine that when "Low" is selected, a configuration variable named "Speed" is set to value "Low" and the "Select Tests" tab is populated with three low-speed tests:

"Select Tests" tab:
- All Tests
  - Low Speed Test #1
  - Low Speed Test #2
  - Low Speed Test #3

Similarly, when "High" is selected on the "Set Up" tab, variable "Speed" is set to "High" and a different set of tests are shown:

"Select Tests" tab:
- All Tests
  - High Speed Test #1
  - High Speed Test #2
  - High Speed Test #3

Using the application's user interface, it is impossible to cause an invalid situation because only the currently available tests are displayed for you to select. However, via the remote interface you can request any test by setting the SelectedTests property. If you ask for an unavailable test, such as asking for High Speed Test #1 when "Speed" = "Low", the automated test application will throw an exception across the remote interface that your client will need to handle.

By first exploring the task via the user interface, though, you can avoid this exception by realizing you must first call SetConfig("Speed", "High") before calling RunTests() for a high-speed test.
Verify the remote commands one at a time

After you've converted some of the manual steps into remote interface commands (see "Determine required tasks by first using the graphical user interface" on page 78), execute them one at a time, either in the debugger or by sending them using the ARSL Command Line Utility. In many cases, you will be able to verify their success by visually inspecting the application on the oscilloscope.
Check the log

The automated test application logs all incoming remote commands to a file. You can visually inspect this file to see how your remote commands executed in relation to other events that get logged.

The log file is named message_.log and may be found in one of these locations:

- For automated test apps that run directly on an oscilloscope:
  - Remote Interface Versions 1.10 and earlier: C:s\scope\apps\(application name)\Scratchpad\n  - Remote Interface Version 1.20 and later: C:s\Documents and Settings\All Users\Application Data\Keysight\Infiniium\Apps\(application name)\Project\n  - Remote Interface Version 1.40 and later:
    - WinXP: C:s\Documents and Settings\All Users\Application Data\Agilent\Infinium_or_FlexDCA\Apps\(application name)\Log\n    - Win7: C:s\ProgramData\Agilent_or_Keysight\Infinium_or_FlexDCA\Apps\(application name)\Log\n
- For automated test apps that run on a separate PC:
  - WinXP: C:s\Documents and Settings\All Users\Application Data\Agilent\Infinium_or_FlexDCA\Apps\(application name)\Project\n    - Or -  
    C:s\Documents and Settings\All Users\Application Data\Agilent\Scope\Apps\(application name)\Log
  - Win7: C:s\ProgramData\Agilent_or_Keysight\(platform)\Apps\(application name)\log\n
where "(platform)" is FlexDCA, Infiniium, InfiniiVision, or M8070A

A standard .NET command gets logged this way:

1/8/2008 11:20:39 AM RPIR 55 <1.0>

The fields contain the following information:

----------------------- ---- -- -----------------------
1 2 3 4

1  Timestamp.
2  Remote command log code.
3  Remote command sequence number.
4  Remote command.
A unique sequence number identifies command/response pairs. The remote command log code types are:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RPIC</td>
<td>Remote Programming Interface Command.</td>
</tr>
<tr>
<td>RPIR</td>
<td>Remote Programming Interface Response.</td>
</tr>
</tbody>
</table>

Here's another example. An ARSL command looks like this:

```
1/8/2008 11:22:36 AM RPIR 73 <1.0>
1/8/2008 11:22:36 AM RPIR 72 <>
```

Here you see that the ARSL command is translated into its .NET equivalent and then executed.

If the remote command results in user messages being generated, these will appear in the log as well. For example:

```
1/8/2008 11:25:22 AM RPIC 74 SelectedTests 50000
1/8/2008 11:25:22 AM RPIR 74 <>
1/8/2008 11:25:24 AM RPIC 75 Run
```

In this example, a test named "Multi-Trials Count Up Test" is selected and run. The "all tests complete" message is logged as well. Here are the field descriptions for user message log entries:

```
1/8/2008 11:25:35 AM TLCL Information All Tests Complete
```

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
</tr>
</thead>
</table>

Messages are grouped into three categories:

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tell</td>
<td>Errors, warnings, and info messages that have only an OK button.</td>
</tr>
<tr>
<td>Ask</td>
<td>Messages include other response types such as &quot;Retry/Cancel&quot; or &quot;Yes/No&quot;.</td>
</tr>
<tr>
<td>AskForData</td>
<td>Messages that require the user to enter a value.</td>
</tr>
</tbody>
</table>

Here is the complete list of user message log codes you may encounter during remote operation:
### Recommended Remote Programming Practices

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALCL</td>
<td>Ask message displayed locally (on oscilloscope).</td>
</tr>
<tr>
<td>ARMT</td>
<td>Ask message redirected to remote client.</td>
</tr>
<tr>
<td>ASPR</td>
<td>Ask message suppressed by remote client.</td>
</tr>
<tr>
<td>DLCL</td>
<td>AskForData message displayed locally (on oscilloscope).</td>
</tr>
<tr>
<td>DRMT</td>
<td>AskForData message redirected to remote client.</td>
</tr>
<tr>
<td>DSPR</td>
<td>AskForData message suppressed by remote client.</td>
</tr>
<tr>
<td>TLCL</td>
<td>Tell message displayed locally (on oscilloscope).</td>
</tr>
<tr>
<td>TRMT</td>
<td>Tell messages redirected to remote client.</td>
</tr>
<tr>
<td>TSPR</td>
<td>Tell messages suppressed by remote client.</td>
</tr>
</tbody>
</table>
5 Developing a Remote Client

This chapter shows you how to develop remote client executables using the Keysight KS8400A Test Automation for PathWave (TAP) version 9, .NET language C#, and the graphical LabVIEW 8.5 programming environment. The Automated Test Application Remote Development Toolkit provides sample projects to enable you to experiment with the remote client development by starting with existing code. C# and LabVIEW implementations are provided.
Developing a Remote Client

Plugin for Keysight KS8400A Test Automation for PathWave

The DigitalTest Apps API plugin for TAP requires TAP version 9 or newer. While the plugin is complete enough to enable you to perform most tasks, the source code for the plugin is included in this toolkit enabling you to modify and extend it if desired:

C:\ProgramData\Keysight\DigitalTestApps\Remote Toolkit\Version x\Source\TAP\Plugins\API\ (Visual Studio 2017 solution)

The primary classes of interest are found in the solution's TestSteps folder. Most of the classes in the folder correspond to a single TAP step, with the exception of a few base classes:

- class TestStep (provided by TAP)
  - class DigitalTestStep (provided by the plugin): Base class for all our plugin steps
    - (most of remaining classes)
    - class PathCorrectionStep: Base class for path correction-related plugin steps
      -- class InfiniiSimConfigureOneChannelStep
      -- class PrecisionProbeConfigureOneChannelStep

If you add new steps, inherit your class from the DigitalTestStep, which:

- Wraps the Run method with exception handling and logging
- Generates the settings summary suffix that appears next to the step names in the test plan list

Instead of modifying the API plugin, consider making all of your local changes in a separate plugin (see below for an example). You can add new steps there or override steps found in the API plugin. By keeping your local changes separated, you will be able to use updates to the API plugin in future N5452A Remote Toolkit releases without having to merge your changes back in.

If you want to programmatically handle and respond to prompts and events generated by the automated test app, then create a new plugin in which you define a new class that inherits from ManageMessageStep and overrides its "OnXxxEvent" methods. For example, "My DDR5 Plugin" containing "ManageDDR5MessagesStep". Then, when you install both plugins, use your new step in place of the DigitalTest Apps API ManageMessagesStep.

An example of how to do this may be found here:

C:\ProgramData\Keysight\DigitalTestApps\Remote Toolkit\Version x\Source\TAP\Plugins\SampleEventHandler\ (Visual Studio 2017 solution)

The source code for the sample UDAs is also included:

C:\ProgramData\Keysight\DigitalTestApps\Remote Toolkit\Version x\Source\TAP\UDA\DemoApps\ (UDA version 3.30 project files)

If you get this error when you build the project:
then configure a switch matrix simulator in the UDA tool using Menu: Tools > Options:
Simple Remote Client

The easiest way to begin is to start with the "Simple Remote Client" demo program.

1. On the computer, browse to the location where the toolkit is installed. In the desired "Source\C#" subdirectory, locate the "SimpleRemoteClient" folder. It contains a C# implementation of the client. Copy this folder to another location on your computer so you can modify the copy without losing the original files.


**NOTE**

Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

3. Using Visual Studio 2013 or newer, open the file "SimpleRemoteClient.sln".

4. In Visual Studio, display the properties page for the SimpleRemoteClient project and go to the "Debug" tab. Enter the IP address of the oscilloscope in the "Command line arguments field".
Build and run. You should see output similar to this:
You can also run this from the command line:

![Command Prompt - SimpleRemoteClient](image)

**File description**

These are the key folders and files in the project directory:

- SimpleRemoteClient.sln – Visual Studio solution file
- SimpleRemoteClient/
  - SimpleRemoteClient.csproj – Visual Studio project file
  - Program.cs – C# source file containing the entire program
  - distrib\ – Directory where build outputs are copied to.

**Source code description**

Here is the function of each of the lines in the program:

1. This defines the namespace the program lives in:
   ```csharp
   namespace SimpleRemoteClient
   ```

2. This names the class the program lives in:
   ```csharp
   internal class Program
   ```

3. This is the method that gets executed when the program is run:
   ```csharp
   private static void Main(string[] args)
   ```

4. This establishes a connection to the application running on the oscilloscope:
   ```csharp
   ```
   The "Keysight.DigitalTestApps.Framework.Remote." prefix indicates that
   IRemoteAte and RemoteAteUtilities are defined in the

5. This sends a remote command to the oscilloscope to execute a property query
   in the automated test application:
   ```csharp
   string appName = remoteAte.ApplicationName;
   ```
   This particular property contains the application's name. Please see Chapter 1,
   **Chapter 1** , “Keysight DigitalTestApps Remote Interface,” starting on page 9, for
   information on other properties and methods available in the automated test
   application's remote interface.
This prints the result in the command window:

```csharp
System.Console.WriteLine(appName + "\nPress any key to finish.");
System.Console.ReadKey();
```

The Simple Remote Client is intended for use as a remote programming learning and experimentation platform. For more realistic (and interesting) implementations, see the sections that follow.
ARSL Command Line Utility Implementation

You may also examine the implementation for, modify, and build the ARSL Command Line Utility.

As with the Simple Remote Client, you will need to copy the file Keysight.DigitalTestApps.Framework.Remote.dll (or Agilent.Infiniium.AppFW.Remote.dll) to the distrib directory of the project.

NOTE
Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

Here are some of the differences from the Simple Remote Client:

• Design

This is more complex, so the implementation uses multiple components: the Program, a type to hold the runtime options, an argument parser and an Arsl executor as summarized in the diagram below:
Notice that all of the interaction with the remote application is contained within the ArslExecutor.

- The ArslExecutor (ArslExecutor.cs) makes the connection to the remote application:
internal void Initialize(string ipAddress, bool useCustomPort, bool verbose)
{
    if (useCustomPort)
    {
        GetRemoteAteOptions options = new GetRemoteAteOptions();
        options.IpAddress = ipAddress;
        options.UseCustomPort = true;
        mRemoteAte = RemoteAteUtilities.GetRemoteAteCustom(options);
        ...
    }
    else
    {
        mRemoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);
        ...
    }
    ...
}

• The ArslExecutor (ArsExecutor.cs) makes all the calls to the remote application. Even though the ARSL utility enables you to execute many different remote interface property and method actions, it only uses one member of the remote interface to accomplish this:

    internal void ExecuteSingleCommand(string command)
    {
        string result = mRemoteAte.ExecuteArsl(command);
        ...
    }

    This particular method enables passing the utility a string representation of a property or method action and having it get executed as a real property or method action.

The rest of program is not specific to remote interface programming and is concerned only with parsing and validating the user input and generating the output.
Simple GUI Remote Client Implementation

You may examine the implementation for, modify, and build the Simple GUI Remote Client.

As with the Simple Remote Client, you will need to copy the file Keysight.DigitalTestApps.Framework.Remote.dll (or Agilent.Infiniium.AppFW.Remote.dll) to the distrib directory of the project.

Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

The design of this application is summarized in the diagram below.
There are two primary design patterns in use: Observer and State. The Observer pattern leads us to place business logic (interaction with the remote application) in a separate module from the main dialog. The State pattern leads us to implement well-structured transitions as the user performs the various steps described in the main dialog.
Here are some remote interface-related highlights from the code:

• The Model (Model.cs) configures the .NET Remoting Interface:

```csharp
internal void Initialize()
{
    string path =
        Path.GetDirectoryName(Assembly.GetExecutingAssembly().Location);
    string configFullPath =
        Path.Combine(path,
    RemotingConfiguration.Configure(configFullPath, false);
}
```

• The Model (Model.cs) makes the connection to the remote application:

```csharp
internal void Connect(string ipAddress)
{
    try
    {
        ...
        mRemoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);
        mRemoteAte.Ping();
    }
    catch (Exception e)
    {
        MessageBox.Show("Could not connect to an application running at "
            + "IP Address: " + ipAddress + "\n\n" + "Reason: "
            + e.Message);
        ...
        return;
    }
}
```

The Ping method is called because the GetRemoteAte method will always return successfully, even if there is no application at the specified address, while Ping (and all the other properties and methods of the remote interface) can only work if the connection is valid.

• The Model (Model.cs) makes all other calls to the remote application

• Determining Available Tests

As mentioned in "Determine required tasks by first using the graphical user interface" on page 78, you may only execute a test via the remote interface if the automated test application is in such a state that the test is available on the "Select Tests" tab of the user interface. Fortunately, the remote interface provides a property that tells you exactly which tests are available at any given time. The Simple GUI Remote Client uses this to build the test list that it presents to the user. Again, in the Connect method:

```csharp
internal void Connect(string ipAddress)
{
    ...
    mAvailableTests = mRemoteAte.AvailableTests;
}
```
This stores the test availability information in the model so it will be accessible by the dialog.

- Test execution

Tests are executed in the Run method (Model.cs) by setting the remote interface property 'SelectedTests' and calling the method 'Run':

```csharp
internal void Run(int testIndex)
{
    try
    {
        int[] testToSelect =
            new int[] { mAvailableTests[testIndex].ID };
        mRemoteAte.SelectedTests = testToSelect;
        mRemoteAte.Run();
    } catch (Exception e)
    {
        MessageBox.Show("An error occurred during the run:
            " + e.Message);
    }
}
```

- Result access

The result of the test is accessed in the Run method (Model.cs) by calling the remote interface GetResults method:

```csharp
internal void Run(int testIndex)
{
    ...
    ResultContainer results = mRemoteAte.GetResults();
    // Remote Interface Versions 1.10 and prior (deprecated in 1.20)
    //mWorstResult = results.WorstResults[0];
    // Remote Interface Versions 1.20 and later only:
    mWorstResult = results.ExtremeResults[0];
} ...
```

This returns a ResultContainer object which contains various details concerning the result.

The rest of program is not specific to remote interface programming and is concerned only with managing the graphical user interface.
Simple Message Handling Remote Client Implementation

You may examine the implementation for, modify and build the Simple Message Handling Remote Client.


NOTE
Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

The design of this application is summarized in the diagram below:

Note that the model-view pattern is not used in this application in order to more clearly highlight the message-handling elements. All relevant code is in the file MainDialog.cs. Here are some remote interface-related highlights from the code:

- Initialization occurs when you click the "Connect" button:

  ```c#  
  private void btnConnect_Click(object sender, EventArgs e)  
  {  
      // Enable forward remote interface  
      // (remote client -> automated test app)  
      mRemoteAte = RemoteAteUtilities.GetRemoteAte(ipAddress);  
  }  
  ```
// Enable asynchronous callbacks
// (automated test app -> remote client)
// User must place the .config file in the same location as the
// remote client's .exe
string path =
Path.GetDirectoryName(Assembly.GetExecutingAssembly().Location);
string configFullPath =
RemotingConfiguration.Configure(configFullPath, false);
mAteEventSink =
RemoteAteUtilities.CreateAteEventSink(mRemoteAte, this, ipAddress);
}

• The AteEventSink object is the key to managing callback activity. It has properties for specifying whether you want prompts issued by the automated test app to be:
  • allowed to display on the scope
  • transported to the remote client PC and displayed there
  • never displayed (programmatically responded to by the remote client via an event handler)

private void chkRedirectMessages_CheckedChanged(
    object sender, EventArgs e)
{
    // Tell my AteEventSink to coordinate with app regarding message
    // redirection
    mAteEventSink.RedirectMessagesToClient =
        chkRedirectMessages.Checked;
    ...
}

private void chkHandleSimpleCallbacksProgrammatically_CheckedChanged(
    object sender, EventArgs e)
{
    if (chkHandleSimpleCallbacksProgrammatically.Checked)
    {
        // Tell my AteEventSink to let me handle simple message callbacks
        // from the app myself
        mAteEventSink.SimpleMessageEvent +=
            mAteEventSink_SimpleMessageHandler;
    }
    else
    {
        // Tell my AteEventSink to automatically handle (display) simple
        // message callbacks from the app
        mAteEventSink.SimpleMessageEvent -=
            mAteEventSink_SimpleMessageHandler;
    }
}

• To programmatically respond to a prompt from the automated test application, the event handler sets a property corresponding to the button on the prompt that is to be "clicked", for example "OK":

private void mAteEventSink_SimpleMessageHandler(
    object sender, MessageEventArgs e)
{
    if (e.Message.Contains("completed")) // This is the prompt the app
        // displays at the end of a run
    {
        e.Response = DialogResult.OK; // Be sure to respond using a
        // DialogResult that is valid for the message being handled
        return;
    }
    ...
}

• At the start of a run, the demo program chooses which thread to make the
  request in:
  • If no callbacks from the app can occur, the Run command may be safely
    executed in the main thread.
  • If callbacks are enabled, the Run command must be executed in a worker
    thread. For more details, please see the "multithreading (see page 104)"
    discussion.

private void btnRun_Click(object sender, EventArgs e)
{
    ...
    if (mAteEventSink.RedirectMessagesToClient)
    {
        // Must use worker thread to prevent deadlock when receiving
        // asynchronous callbacks from app during a run
        new Thread(mRemoteAte.Run).Start(); // This demo program will
            // immediately proceed to the next line of code regardless
            // of the state of the run
    }
    else
    {
        // No callbacks will be sent to the remote client, so it is
        // safe to call Run() in the main thread
        mRemoteAte.Run(); // This demo program will block at this line
            // of code until the run is complete
    }
}

• An automated test app will only allow one remote client to be registered to
  handle callbacks. Therefore, when the remote client exits it performs this
  cleanup action:

private void mRemoteClientClosing()
{
    if (mAteEventSink != null)
    {
        // Tell my AteEventSink to notify the app that I am no longer
        // the receiver for callbacks (so another remote client can
        // register with the app)
        mAteEventSink.Dispose();
    }
}
Message Handling Remote Client Implementation

You may examine the implementation for, modify and build the Message Handling Remote Client.

As with the Simple Remote Client, you will need to copy the file Keysight.DigitalTestApps.Framework.Remote.dll (or Agilent.Infiniium.AppFW.Remote.dll) to the distrib directory of the project. You will also need to copy this additional file: Keysight.DigitalTestApps.Framework.Remote.config.

NOTE

Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

The design of this application is summarized in the diagram below:
There is one primary design pattern in use: Observer. The Observer pattern leads us to place business logic (interaction with the remote application) in a separate module from the main dialog.

Here are some remote interface-related highlights from the code:

- .NET Remoting
The Model (Model.cs) configures the .NET Remoting Interface to enable the callback path (scope->client):

```csharp
internal void Initialize(...) {
    string path = Path.GetDirectoryName(Assembly.GetExecutingAssembly().Location);
    RemotingConfiguration.Configure(configFullPath, false);
    ...
}
```

**NOTE**
The configuration file's contents are standard and may be used for any remote client requiring callback capability.

- **Groups and Namespaces**
  All of the controls in the "Core Features" group use remote interface members contained in the basic namespace, Keysight.DigitalTestApps.Framework.Remote:
  - Run: mRemoteAte.Run();
  - Suppress All Messages: mRemoteAte.SuppressMessages = value;
  - Suppress Simple Messages: mRemoteAte.SuppressSimpleMessages = value;
  - Suppress Data Input Messages: mRemoteAte.SuppressDataInputMessages = value;
  - Connect Prompt Action: mRemoteAte.ConnectionPromptAction = value;
  - Check Signal Prompt Action: mRemoteAte.SignalCheckFailAction = value;

  All of the controls in the "Advanced" group use remote interface members contained in the advanced namespace, Keysight.DigitalTestApps.Framework.Remote.Advanced:
  - Redirect Messages: mAteEventSink.RedirectMessagesToClient = value;
  - Override Default Handler: mAteEventSink.SimpleMessageEvent += OnSimpleMessage;

- **Event Sink**
  Both of the advanced features require the automated test application running on the oscilloscope to be able to call a function on the remote client. This is enabled by use of a class called "AteEventSink" (contained in the Keysight.DigitalTestApps.Framework.Remote.dll assembly). All the remote client has to do is instantiate an AteEventSink and keep it alive until the remote client closes:
mAteEventSink = RemoteAteUtilities.CreateAteEventSink(
    mRemoteAte, 
    mMainDialog, 
    mIpAddress);

The event sink uses its constructor parameters to establish a two-way link between the remote client and the application running on the oscilloscope. It also exposes properties and events that enable the remote client to activate advanced communication features, such as:

- Redirecting dialogs to the client:

  mAteEventSink.RedirectMessagesToClient = true;

  This property tells the EventSink to configure the application running on the oscilloscope to send user messages to the EventSink instead of displaying them on the oscilloscope. Then the EventSink will use a default algorithm to display the message on the client.

- Overriding the default message handler:

  mAteEventSink.SimpleMessageEvent += OnSimpleMessage;

  This event enables the remote client to register a client-defined method for EventSink to use instead of its default algorithm. So, when RedirectMessagesToClient is set to true and a handler is subscribed to the SimpleMessageEvent event, the EventSink will forward on messages received from the application running on the oscilloscope to your client to do with as you please. In the example program, the client simply appends some text to the original message and displays it:

  private void OnSimpleMessage(object sender, MessageEventArgs e) 
  {
      e.Response = TellUser("Local handler processed this simple " + 
                 "message:\n\n" + e.Message + "\n\nClick one of the " + 
                 "buttons provided by the message sender:", 
                 e.Buttons, 
                 e.Icon, 
                 e.DefaultButton);
  }

  If you need to detect a certain message in order to perform a related task, you could examine the e.Message property for words that appear in the message. However, this approach is fragile because the application may change the message slightly over time. Instead, use the e.ID property, which is stable over time.

  **MULTITHREADING**
Message redirection is a powerful capability, but it adds complexity to the design of the remote client. In particular, while message redirection is enabled, you run the risk of deadlock. Here are two such scenarios (remember, these apply only when message redirection is enabled):

a. Executing a remote interface property action or method call in the GUI thread. When the client sets a property or calls a method in the automated test application's remote interface, if the remote action leads the automated test application to issue a redirectable message, then deadlock will ensue:

- The client's GUI thread is occupied waiting for the property action or method call to return. It will not process the incoming redirected message.
- The automated test application's GUI thread is occupied waiting for the redirected message to get answered.

To prevent this scenario, execute in a worker thread any remote interface property action or method call that may result in a redirected message.

b. Updating the GUI directly from the remote interface. If you follow the design guideline from the previous step and execute remote actions from within a worker thread, you may still run into a similar deadlock situation. For example, consider this GUI code:

```csharp
// GUI code
private void chkRedirectMessagesToClient_CheckedChanged(object sender, EventArgs e)
{
    mModel.RedirectMessagesToClient = chkRedirectMessagesToClient.Checked;
    UpdateDialog();
}

private void UpdateDialog()
{
    chkSuppresSimpleMessages.Checked = mModel.SuppressSimpleMessages;
    ...
}

// Model code
public bool RedirectMessagesToClient
{
    set { return mRemoteAte. RedirectMessagesToClient = value; }
}

public bool SuppressSimpleMessages
{
    get { return mRemoteAte.SuppressSimpleMessages; }
}
```
This sequence of events may lead to deadlock:

i. If the application currently has a dialog displayed locally on the oscilloscope (for example, "all tests completed").

ii. On the remote client, the user clicks the RedirectMessagesToClient checkbox to enable this mode.

iii. The callback code in chkRedirectMessagesToClient_CheckedChanged begins.

iv. A RedirectMessagesToClient property set is sent to the automated test application and control returns to the client.

v. The client begins its UpdateDialog method.

vi. Asynchronously, the dialog that was being displayed on the oscilloscope at the beginning of this scenario is redirected to the client.

vii. The client attempts to query the automated test application during UpdateDialog.

This would result in deadlock:

- The automated test application cannot respond to the client's query because it is busy waiting for a response from the client for the redirected message.
- The client will not display the redirected message because it is busy waiting for a response from the automated test application for the remote query.

To prevent this scenario, do not send remote commands to the automated test application while a redirected message needs attention on the remote client. In the above scenario, you would resolve the design problem by replacing the model's SuppressSimpleMessage getter implementation with one that caches the automated test application's state in a field and returns this field instead of querying the oscilloscope.

Here is actual message handling remote client implementation that demonstrates how design can avoid both of the above scenarios:

In MainDialog.cs:

```csharp
// Define a delegate for a method that takes a single string parameter and returns void
private delegate void VoidStringDelegate(string s);

// Executed when the user clicks "Run"
private void btnRun_Click(object sender, EventArgs e)
{
    ...
    // Call the Model's version of Run in a worker thread
    VoidStringDelegate dlgtRun = mModel.Run;
    dlgtRun.BeginInvoke(txtTestID.Text, null, null);
    // BeginInvoke immediately returns even though the run is not completed.
```
// Now the GUI is ready to handle any callbacks from the
// automated test application that may occur during the run.

In Model.cs:

internal void Run(string testId)
{
    // Executing in a worker thread
    ...
    mRemoteAte.RunTests(testId);
    ...
}

public bool SuppressSimpleMessages
{
    get
    {
        // Return a field...don't query the oscilloscope
        return mSuppressSimpleMessages;
    }
    set
    {
        mSuppressSimpleMessages = value;
        mRemoteAte.SuppressSimpleMessages = mSuppressSimpleMessages;
    }
}

• Disposal

To facilitate proper resource cleanup, always dispose of the event sink. The
Model class (Model.cs) implements this using a standard pattern:

private bool mAlreadyDisposed;

public void Dispose()
{
    Dispose(true);
    GC.SuppressFinalize(this);
}

~Model()
{
    Dispose(false);
}

protected virtual void Dispose(bool isDisposing) {
    if (mAlreadyDisposed)
    {
        return;
    }

    if (isDisposing)
    {
        mAteEventSink.Dispose();
    }
mAlreadyDisposed = true;
}
LabVIEW Simple Remote Client

This section describes how to create your own remote client using the LabVIEW programming environment. In addition to requiring the Keysight.DigitalTestApps.Framework.Remote.dll file (or Agilent.Infinium.AppFW.Remote.dll, see "On the Client" in the Keysight DigitalTestApps Programming Getting Started guide for a list of minimum requirements), LabVIEW clients use an interface adapter assembly, "Keysight.DigitalTestApps.RemoteTestClient.dll" (or Agilent.Infinium.RemoteTestClient.dll). This file is also provided in this Toolkit in the desired Tools\LabVIEW\LabVIEW Remote Adapter subdirectory.

**NOTE**
Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

1. Create a new folder in C:\Labview.
2. Copy the following files to the folder created:

**NOTE**
Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

3. Launch Labview and create an empty project.
4 Add the following files to the project:
   b  Keysight.DigitalTestApps.RemoteTestClient.dll
5 Add a new VI to the project.

6 Add a Constructor node to the Block Diagram of the VI and select the RemoteClient (String ApplicationPath) constructor from the Keysight.DigitalTestApps.RemoteTestClient.dll (or Agilent.Infiniium.RemoteTestClient.dll).
7 Add a string constant and link it to the constructor created earlier. The string constant value must be pointing to the directory where Keysight.DigitalTestApps.RemoteTestClient.dll.config (or Agilent.Infiniium.RemoteTestClient.dll.config) is located. In the case of this example it will be in C:\Labview as it copied there in step 1).

8 Add a While Loop node to the block diagram of the VI.
9 Add a Event Structure node into the While Loop node added in step 8.

10 Add an Ok Button to the Front Panel. Rename the button label to "Connect".
11 Edit the Timeout event in the Block Diagram to wait for a Mouse Down on the newly added Connect button.
12 Add a Invoke node and select the Connect(String IP) method. Create a string constant with the IP of the scope where the automated test application is running.
13 Create the following interface on the Front Panel using:
   a  One Ok Button
   b  One String Control
   c  One String Indicator
14 Add an event for the Execute ARSL button as you did for the Connect button.
15 Add an Invoke node to the block diagram and select the Execute ARSL method.

16 Link the ARSL Command and ARSL Output nodes to the ExecuteARSL node as shown below.
17 Add a False Constant node and link it to the While node Loop Condition as shown below.

18 Bring up the Front Panel VI and run it to test this example. Click on the Connect button and enter into the ARSL Command text "Available Tests?" minus the quotes. Click on the Execute ARSL button once the command has been entered.
If the connection and execution was successful, the list of available tests should be displayed in the ARSL Output Indicator.
LabVIEW Demo Client Construction

This section describes how to create your own remote client using the LabVIEW programming environment. In addition to requiring the Keysight.DigitalTestApps.Framework.Remote.dll file (or Agilent.Infiniium.AppFW.Remote.dll, see "On the Client" in the Keysight DigitalTestApps Programming Getting Started guide for a list of minimum requirements), LabVIEW clients use an interface adapter assembly, "Keysight.DigitalTestApps.RemoteTestClient.dll" (or Agilent.Infiniium.RemoteTestClient.dll). This file is also provided in this Toolkit in the desired Tools\LabVIEW\LabVIEW Remote Adapter subdirectory.

**NOTE**
Please see the readme.txt file found in the "Agilent-Keysight Transition" or "Keysight Apps only" subdirectories for guidance on the files to use for your remote client.

The following topics describe how to create your own remote LabVIEW client. For a detailed description of the remote API for LabVIEW, see the documents described in "Remote Interface Documentation" on page 10.

**NOTE**
In order to import and use the Keysight.DigitalTestApps.RemoteTestClient.dll (or Agilent.Infiniium.RemoteTestClient.dll), all vi's that reference or use the dll need to be part of a Labview project. Once a project has been created, add a new or existing vi to it so the Keysight.DigitalTestApps.RemoteTestClient.dll (or Agilent.Infiniium.RemoteTestClient.dll) can be referenced correctly.

Creating a Remote Client

![Remote Client Constructor](image)

**Figure 1** Remote Client Constructor

Registering an Event

Insert a .Net Register Event Callback node from the menu selection. There are three events available for registration:

1. `DataInputEvent`
2. `TestListEvent`
3. `SimpleMessageEvent`

Select which event to register to from the drop down, and create a callback vi.

TestList Event

The `TestListChangedEventArgs` parameter is passed during the `TestListEvent`. The example above shows how the values in a List box are updated with the names of the Available Tests. Please refer to [Keysight DigitalTestApps Remote Interface for LabVIEW](#) help file for more details on the `TestListChangedEventArgs` properties.

![Figure 2](image1.png)

**Figure 2  Registering an Event**

![Figure 3](image2.png)

**Figure 3  TestList Changed Event**
### SimpleMessage Event

![SimpleMessage Event Diagram](image)

**Figure 4  SimpleMessage Event**

The MessageEventArgs parameter is passed during the SimpleMessageEvent. The example above shows how a single "OK" button message is handled. Different messages may have different expected return values. Please refer to the Keysight DigitalTestApps Remote Interface for LabVIEW help file for more details on the MessageEventArgs properties.

### DataInput Event

![DataInput Event Diagram](image)

**Figure 5  DataInput Event**

The MessageEventArgs parameter is passed during the DataInputEvent. The example above shows a MessageEventArgs being passed to the Inputprompt.vi for user input. When the user has entered the data and clicked the "OK" button, the response will be sent back to the application.
Different messages may have different expected return values. Please refer to the Keysight DigitalTestApps Remote Interface for LabVIEW help file for more details on the MessageEventArgs properties.

### Loading a Project

#### Figure 6  Loading a Project Part A

Insert an Invoke node from the menu and select "SetLoadProjFullPath(String)" as the method. Supply the method the full path with the project name.

#### Figure 7  Loading a Project Part B

Invoke "LoadProjectCustom" once the project full path has been supplied.

### Discarding Unsaved Changes

#### Figure 8  Discard Unsaved Changes

To discard unsaved changes when loading a project, invoke the "SetDiscardProjChanges(bool)" before invoking the "LoadProjectCustom" method.
Saving a Project

Figure 9  Saving a Project Part A

Insert an Invoke node from the menu and select "SetSaveProjName(string)" as the method. Supply the method the full path with the project name.

Figure 10  Saving a Project Part B

Invoke "SaveProjectCustom" once the full path has been supplied.
Setting a Config

The example above shows how to Set a Configuration value. Insert an Invoke node from the menu and select SetConfig(string,string) as the method. Supply the Variable Name and Variable Value to set the configuration.

Overwriting an Existing Project

To overwrite an existing project during a save, invoke "SetSaveOverwriteProj(bool)" method with a Boolean value before invoking the "SaveProjectCustom" method.

Getting a Config

Figure 11  Setting a Configuration

Figure 12  Overwrite an Existing Project

Figure 13  Getting a Configuration Value
The example above shows how to Get a Configuration value. Insert an Invoke node from the menu and select GetConfig(string) as the method. Supply the Variable Name to get the value for that variable.

Connection Prompt Action

Figure 14  Connection Prompt Action

When manual connection changes are required by the remote application, the user will be prompted. To select the response to these connection change prompts, invoke "SetConnectionPromptAction(String)" method with either "AutoRespond", "Display", or "Abort".

Signal Check Fail Action

Figure 15  Signal Check Fail Action

Certain applications perform a series of checks before running a test to ensure that the signal provided is correct. In cases where the signal provided does not meet the criteria, a prompt will occur. To select the response to these connection change prompts, invoke "SetSignalCheckFailAction(String)" method with either "AutoRespond", "Display", or "Abort".

Running Tests

Figure 16  Running Tests Part A
The example above shows how to run a set of tests. Insert an Invoke node from the menu and select TestNameToID(string) as the method. Supply the test name to the method and the corresponding TestId will be returned. Pass the array of TestIDs to the "SetSelectedTests()" function.

After that, invoke "RunCustom()" to execute the tests.

Increasing Number of Trials

The above example shows how to increase the number of trials to run each time the tests are executed (as well as the number of trials that are retrieved when obtaining results). Invoke the "SetStopConditionCount(int Trials)" method and set it to the number of trials each test is to be executed. Invoke "SetResultOpsMaxTrial(int Count)" to set the number of trials results to return. Note that when more than one trial is selected, the Test Plan feature is disabled (and the LabVIEW interface is updated).
Enabling Test Plan Feature

The above example shows how to enable the Test Plan feature. The feature is only available if the remote application supports it. Invoke the "SetTestPlanEnabled(bool Status)" method and pass it a boolean value.

Skipping Completed Permutations

The example above shows how the application can be made to skip completed permutations in the Test Plan feature. Invoke the "SetTestPlanSkipPermu(bool status)" method and pass it a Boolean value.

Execute ARSL

The example above shows how to execute an ARSL command. Insert an Invoke node from the menu and select ExecuteARSL(string) as the method. Supply the ARSL command string to the method which will return the Status/Value as a String.
Connect

The example above shows how to connect to the automated test application. Insert an Invoke node from the menu, and select Connect(string) as the method. Supply the IP address of the oscilloscope where the automated test application is running.

Appending/Replacing Test Results

The user is given a choice to either replace the test results of previous runs with the new run or append the previous test results with the new run. To do so, invoke the "SetExistingResultsAction" method with either "Replace" or "Append" as the parameter.

Getting Results

Figure 22  Connecting to the Application

Figure 23  Appending/Replacing Test Results

Figure 24  Getting Results Part A
The example above shows how to get test results for selected tests from the listbox. First, get the selected test names from the list box and pass them to the "TestNametoID" method to get the Test IDs. Next, pass the list of Test IDs to the "SetResultOpsTestIDs" method.

Invoke "GetResultsCustom" which will return a "ResultContainer" object that has the property "WorstResults". The "WorstResults" property contains several details for the test results. Please refer to the Keysight DigitalTestApps Remote Interface for LabVIEW help file for more details on the various properties used by the Results.

Delete Results

The example above shows how to delete the results for all tests. Insert an Invoke node and select DeleteResults().
Refreshing the Test List

The example above shows how to get the list of available tests. Insert an Invoke node and select GetAvailableTestList(). It will return an array of TestInfo objects. From the array of tests, extract the names of the tests to populate in the list box. Please refer to *Keysight DigitalTestApps Remote Interface for LabVIEW* help file.

Updating Your Automated Test Application

From time to time, automated test application updates are released. When this occurs, the associated remote interface version may be different as well (for example, in order to provide new functionality). Recall that you can use the ARSL Command Line Utility (see "ARSL Command Line Utility" on page 18) to quickly determine the remote interface version used by an application. If it has changed, you need to update these two files in your LabVIEW directory in order to use the new functionality:


For more information, see Chapter 2, “Using Sample Remote Clients,” starting on page 17.

Use the following steps to update these files in your LabVIEW project:

1. Remove all copies of the dlls from C:\LabView and any subfolders within them.
2. Place the new copies of the dlls in C:\LabView.
3. Launch the example as described in "LabVIEW Demo Remote Client" on page 31. If you receive the following prompt during the update, click OK to proceed:
4 Open each of the sub-VIs that are marked in the red boxes and resave them.

5 Save the main VI
6 Save the project and exit.
6 Troubleshooting

How to Manage the App Migration to Keysight / 134
Error Messages and Resolution / 135
How to Check Which Port an Application is Using / 138
How to Configure a Remote Interface User Port / 140
If your PC Has Two Network Interface Cards / 142
How To Test Two-way .NET Remoting Between Your PC and Your Scope / 143

The best place to start when troubleshooting remote interface difficulties is to verify the machine running the automated test application (oscilloscope or PC) is set up properly. The easiest way to do this is to run the ARSL command line utility on the remote computer and see if you can send the remote query "ApplicationName?" to the automated test application. See "ARSL Command Line Utility" on page 18 for instructions on using this utility.
How to Manage the App Migration to Keysight

Agilent’s Electronic Measurement business is now Keysight Technologies, Inc., so automated test apps are now branded as Keysight. Which documents and remote support assemblies you need to use to develop your remote client depends on whether you need to control Agilent-branded apps.

• If you only need to control Keysight apps, use the documents, sources and tools found in the main toolkit installation directory.

• If you need to control Agilent apps, please see the Deprecated_ReadMe.txt document in the "Deprecated" subfolder.
Error Messages and Resolution

Here are some common error messages and resolution steps:

**Could not load file or assembly 'Keysight.DigitalTestApps.Framework.Remote'**

Check:

1. Ensure a copy of the file Keysight.DigitalTestApps.Framework.Remote.dll is placed in the same directory as the remote client executable (see "On the Client" in the Keysight DigitalTestApps Programming Getting Started guide).

**The remote interface of the target application has been disabled by local user**

Check:

1. The automated test application running on the target machine (oscilloscope or PC) must have its remote interface enabled (see View->Preferences::Remote tab). Another user may have manually disabled the remote interface to protect a critical and/or long-duration test running on the target machine from being accidentally interrupted by a remote user.

**A connection attempt failed because the connected party did not properly respond after a period of time, or established connection failed because connected host has failed to respond**

Check:

1. The Windows Firewall on the machine running the automated test application must have these port exceptions defined (this is automatically taken care of during the automated test app's installation):

   - Legacy (Agilent) apps require ports 9944 and 49944
   - Keysight apps require ports 49944 and 59944
   - Various names may exist for these exceptions (differences are unimportant).

**The network address is invalid, No connection could be made because the target machine actively refused it**

Check:

1. The IP address you provided should be the address of the target machine running the automated test application (oscilloscope or PC). Ensure the remote client computer can see this machine.

2. A remote-capable automated test application must be installed and running on the target machine.
3 (Real-time 9xxx and 9xxxx Series Infiniium versions 3.19 and older only, Remote Interface versions 1.90 and older only) An automated test application remote control license must be installed on the oscilloscope. You can verify by checking the Infiniium Help> About Infiniium dialog and looking for the name "App Remote" in the list of installed options.

4 The automated test application must have activated a remote interface network port (for instructions, see "How to Check Which Port an Application is Using" on page 138). If it activated a user-defined port, you must access the application using the helper method RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to true. The helper method RemoteAteUtilities.GetRemoteAte() can only access applications via the two standard ports.

The target application did not respond

Do the following:
1 Close the automated test application.
2 Configure a user-defined remote interface port on the target machine (for instructions, see "How to Configure a Remote Interface User Port" on page 140).
3 Restart the automated test application and verify it has enabled its remote interface (for instructions, see "How to Check Which Port an Application is Using" on page 138).
4 In your remote client, access the automated test application using the helper method RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to true.

The target machine has an invalid user port entry

Check:
1 When using RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to true, the target machine running the automated test application must have a user-defined remote interface port (for instructions, see "How to Configure a Remote Interface User Port" on page 140).

Method not found

Check:
1 The client found a remote-capable automated test application running on the target machine (oscilloscope or PC), but the remote interface property or method you attempted to use was not supported by the application. Ensure the property or method is supported in the version of the remote interface version used by the application. The version can be found in the application's Help> About dialog (if it is not there, the version is prior to 1.20). Then check the help file Keysight DigitalTestApps Remote Interface for .NET.chm (see "Remote
**Interface Documentation** on page 10: each property and method is also annotated with the versions it is supported in.

2 Please visit: [www.keysight.com/find/scope-apps](http://www.keysight.com/find/scope-apps) to see if there is a newer version of your automated test application available for download from Keysight Technologies.

System.Runtime.Remoting.RemotingException: This remoting proxy has no channel sink which means either the server has no registered server channels that are listening, or this application has no suitable client channel to talk to the server.

Check:

How to Check Which Port an Application is Using

In the automated test application running on the target machine (oscilloscope or PC), open the View > Preferences dialog. On the Remote tab, in the Network Port Status group, the port being used by the remote interface subsystem will be marked "Active". If no user-defined remote interface port has been set on the target machine, then when the application launches it will attempt to activate one of the two standard ports:

If a user-defined remote interface port (5000 in the example below) has been defined on the target machine, then when the application launches it will attempt to activate it first:
For more information, see "How to Configure a Remote Interface User Port" on page 140.

**NOTE**

When you use the ARSL command line utility –up option, it will connect to the automated test app using RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to true. See “ARSL Command Line Utility” on page 18 for instructions on using this utility.
How to Configure a Remote Interface User Port

1. Identify an available network port on the target machine.

   On the target machine, in a command window enter `netstat -aon` (the letter o, not the number 0). The resulting output lists ports currently in use on that machine. In the TCP section, look for a port number in between 49152 and 65535 that does not appear in the list. In the example below, you could select any number from that range because none of them are in use:

   ![Netstat Output Example]

2. On the target machine, add a string value named "RemoteInterfacePort" to registry key.

   For Agilent apps:
   - (Windows XP) HKEY_LOCAL_MACHINE\SOFTWARE\Agilent\Infinium\Apps
   - (Windows 7) HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Agilent\Infinium\Apps

   For Keysight apps:
   - *(Windows 7) HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Agilent\Infinium\Apps
     or
   - (Windows 7/10) HKEY_CURRENT_USER\SOFTWARE\Keysight\DigitalTestApps

   Then assign the value of the port number you chose above to RemoteInterfacePort.

   * This legacy registry key will be supported by Keysight apps until August 1, 2016. For more information on the migration of apps from Agilent to Keysight, please see "How to Manage the App Migration to Keysight" on page 134.
3 On the target machine, add a TCP port rule/exception (for the port number you chose above) to the Windows Firewall.

4 On the target machine, ensure the "Remote Registry" service is running.

**NOTE**

When you use the ARSL command line utility –up option, it will connect to the automated test app using RemoteAteUtilities.GetRemoteAteCustom() with option UseCustomPort set to true. See "ARSL Command Line Utility" on page 18 for instructions on using this utility.
If your PC Has Two Network Interface Cards

The remote interface uses Microsoft .NET Remoting technology. When a remote client (optionally) activates the callback path (see "Keysight.DigitalTestApps.Framework.Remote.Advanced" on page 14), .NET Remoting by default uses the IP address of the primary NIC configured in the client’s operating system.

You have three options:

- Use the `RemoteAteUtilities.CreateAteEventSinkCustom` method, which will automatically select a NIC that is on the same subnet as the automated test application you are controlling. For more information on configuring the callback path, see "Message Handling Remote Client Implementation" on page 100. For more information on the `CreateAteEventSinkCustom` method, see the help file: Keysight DigitalTestApps Remote Interface for .NET.

-OR-

- Add this property to your client’s `Keysight.DigitalTestApps.Framework.Remote.config` file to tell .NET Remoting to use your private network IP address for compliance app callbacks:

  ```xml
  <channel ref="tcp" name="ATECallbackTCP" port="49946" machineName="196.16 8.0.2">
  ```

-OR-

- Make the required NIC primary. Here is a website that describes how to assign which NIC on your client is considered by the OS to be primary:


  **NOTE**

  Replace "196.168.0.2" with your actual network IP address.
How To Test Two-way .NET Remoting Between Your PC and Your Scope

The remote interface uses Microsoft .NET Remoting technology. Included in this toolkit are a pair of sample client and server applications that exercise a bi-directional .NET Remoting interface. You may use these apps to verify .NET Remoting is working between your remote client PC and your oscilloscope.

1 Copy the Miscellaneous\Tools\C#\Dot Net Remoting Server\ folder to your oscilloscope desktop.

2 Copy the Miscellaneous\Tools\C#\Dot Net Remoting Client\ folder to your remote client PC desktop.

**NOTE**

The source code for both of these applications may be found in the Miscellaneous\Source\C#\ directory.

3 On the oscilloscope:
   a (Optional) Edit the DotNetRemotingServer.exe.config file to use a different network port.
   b Run DotNetRemotingServer.exe. The following screen will display:

   ![Dot Net Remoting Server](image)

   When the server receives commands from the Dot Net Remoting Client, the server will display them in the command history listbox. Use the **Clear** button to clear this list at any time.

   The **Generate Event** button enables you to manually initiate a single callback event. If the Dot Net Remoting Client is subscribed to receive callbacks, then the client will receive a message from the server and acknowledge it in the client’s user interface.

4 On the remote client PC, run DotNetRemotingClient.exe. The following screen will display:
5 Enter the IP Address of the scope the DotNetRemotingServer application is running on.

6 Select a port that matches the value found in the DotNetRemotingServer.exe.config file on the scope.

When you install any Keysight automated test application on your oscilloscope, it opens up ports 49944 and 59944 in the firewall (These are the primary and alternate ports a remote client will automatically try when connecting to one of those applications.) If you select any other port, ensure that port is opened in the scope’s firewall.

7 Click Connect. If successful, the rest of the controls will become available and a “Ping” command will be sent to the server. The server will acknowledge receiving commands from the client in the server’s user interface.

Use the Run and Stop buttons to send a command to the server to make it start and stop running its test program. This program is a simple loop that generates callback events once-per-second, which the server sends to the client if the client is subscribed to receive them.

Use the Subscribe and Unsubscribe buttons to cause the client to register/unregister to receive callback events from the server. When the client receives callback messages from the Dot Net Remoting Server, the client will show them in the callback history listbox.

Use the Clear button to clear this list at any time.
Symbols

.NET programming languages, 52
.NET Remoting, 101
.NET to ARSL syntax translation, 44

A

Advanced group, 102
application did not respond, 136
Application Sequencer, 39
ARSL command line utility, 18, 90
ARSL syntax, translating from .NET, 44
ArslExecutor, 91
AteEventSink class, 14, 102
Automated Test Engine Remote Scripting Language (ARSL), 44
available tests, 95

C

class, program, 88
configuration variables and values, 11
connected host failed to respond, 135
connection failed, 135
connection refused, 135
connection, establishing, 88
copyright, 2
Core Features group, 102
custom types, 9, 45

D

deadlock, 103
default message handler, overriding, 103
default settings, automated test application, 26
disposal, 106
double quotes, 44

E

error messages, 135
error messages in log, 81
event handling, .NET, 58
event handling, Python, 72
event sink, 102
exception types, 15

ExecuteArsl() remote interface), 44
execution, test, 96

F

file description, 88

G

groups, 102

H

how to use this book, 3

I

in this book, 3
info messages in log, 81
invalid user port entry, 136
IP address of oscilloscope, 32
IP address of server, 18, 20, 24, 28
IRemoteAte interface, 14

K

Keysight KS8400A Test Automation for PathWave (TAP), 42

L

LabVIEW demo client, 120
LabVIEW demo remote client, 31
LabVIEW simple remote client, 27, 108
licensing requirements, 135
log, checking, 80

M

message handler, overriding default, 103
message handling remote client, 24, 100
messages, error, 135
method not found, 135
methods, 9
multithreading, 103

N

namespace, program, 88
namespaces, 102
network interface cards (NIC), two, 142
NIC, primary, 142
notices, 2

O

overriding the default message handler, 103

P

parallel testing, .NET, 59
Ping method, 95
plugin for Keysight KS8400A Test Automation for PathWave, 84
primary NIC, 142
properties, 9
Python for .NET package, 61
Python programming language, 61
PyVISA package, 61

Q

quotes, 44

R

recommended remote programming practices, 77
redirecting messages to client, 103
remote client, developing, 83
remote command log code types, 81
remote commands, verifying, 79
remote interface, 9
remote interface disabled by local user, 135
remote interface user port, 140
RemoteAteUtilities class, 14
RemotingException, 137
reserved characters, 44
result access, 96
ResultContainer object, 96

S
sample remote clients, 17
Select Tests tab, 78
Set Up tab, 78
simple GUI remote client, 20, 93
simple message handling remote client, 22, 97
simple remote client, 86
single quotes, 44
source code description, 88
spaces, 44
switch matrix, .NET, 58
switch matrix, .NET, automatic mode, 58
switch matrix, .NET, either mode, 59
switch matrix, .NET, manual mode, 58
switch matrix, ARSL, 50
switch matrix, ARSL, automatic mode, 50
switch matrix, ARSL, either mode, 51
switch matrix, ARSL, manual mode, 50
switch matrix, Python, 74
switch matrix, Python, automatic mode, 75
switch matrix, Python, either mode, 76
switch matrix, Python, manual mode, 75

T
TAP, Keysight KS8400A Test Automation for PathWave, 42
target application did not respond, 136
tasks, determining, 78
threads, 103
translating .NET to ARSL syntax, 44
troubleshooting, 133
two-way .NET remoting, 143

U
user message log code categories, 81
user message log codes, 81
user messages in log, 81
user port, remote interface, 140

W
warning messages in log, 81
warranty, 2
Windows Firewall exceptions, 135